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1.1 Using this manual 

This user manual contains all necessary information that is needed for the commissioning and 
operation of the described product. 

 Read this user manual completely before operating the product for the first time.  

 Consider this user manual to be a part of the product and store it in an easily accessible 
location.  

 If this user manual is lost, please contact BAUR GmbH or your nearest BAUR 
representative (http://www.baur.eu/baur-worldwide). 

 

1.2 Validity of this user manual 

This user manual applies for the Syscompact 4000 cable fault location system and the BAUR 
system software for cable fault location from version 4.4 and describes all functions. 

The availability of individual functions and methods depends upon the system configuration. 
 

1.3 Structure of safety instructions 

The safety instructions in this user manual are presented as follows: 
 

Danger 
symbol 

 

 SIGNAL WORD  

Type of danger and its source 

Possible consequences of violation. 

 Measure to prevent the danger. 

If a dangerous situation could arise at a specific step, the safety instruction is displayed 
immediately before this dangerous step and is shown as follows:  

SIGNAL WORD 

Type of danger and its source. Possible consequences of violation. 

1. Measure to prevent the danger. 

  

1 ABOUT THIS MANUAL  
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Danger levels 

Signal words in the safety instructions specify the danger levels. 
   

 DANGER Will lead to severe injuries or death. 

 WARNING May lead to severe injuries or death. 

 CAUTION May lead to light to moderate injuries. 

NOTICE May lead to material damage. 

  Danger symbols  
 

 
General danger 

 
Risk of electric shock 

 
Danger of suffocation due to carbon dioxide 

 
Dangerous for persons with pacemakers 
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1.4 View Settings 
 

Symbol Meaning 

  You are requested to perform an action. 

1. 

2. ... 

Perform the actions in this sequence. 

a. 

b. ... 

If an operation consists of several operating steps, they are specified with 
"a, b, c". Perform the operating steps in this sequence. 

1 

2 ... 

Numbering in the legend 

  List 

 

Indicates further information on the topic. 

 

Indicates tools required for the subsequent tasks. 

 

Indicates spare parts required for the subsequent tasks. 

 

Indicates required cleaning agents. 

 
 

1.5 Note on the screenshots and graphics used 

The setup of the system depends upon the configuration. The graphics show a possible 
system setup for the cable fault location system as an example. 

The screenshots and graphics used are intended to illustrate the procedure and may differ 
from the actual state. 

Cable drum rack 

The connection diagrams and pictures of the system show the KTG M3 cable drum rack. 

Connection diagrams 

The connection diagrams for screened cables show the connection to 3-phase cables with 
separately screened phases as an example. The connection is the same for other cable types. 
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All BAUR devices and systems are reliable and are manufactured as per state-of-the-art 
technology. The individual parts and the finished devices are subject to continuous testing by 
our qualified personnel as part of our quality assurance system. Each device is fully tested 
before delivery.  

However, the operational safety and reliability in practice can be achieved only when all 
necessary measures have been taken. The responsible body1 and operator2 of the device or 
system are responsible for planning these measures and monitoring their implementation.  

Before operating the device or system you should read and understand this user manual and 
the user manuals of all integrated devices.  

 

2.1 Intended use 

The system is used for the pre-location and pin-pointing of high-resistive, low-resistive and 
intermittent faults on low- and medium-voltage cables and for cable testing under DC voltage. 

If the system is not used in accordance with this stipulation, safe operation cannot be 
guaranteed. The user is liable for any damage to persons and property resulting from incorrect 
operation! 

Proper use also includes 

 compliance with all instructions in this user manual, and all other applicable documents, 

 compliance with the technical data and connection requirements given on the rating plate 
and in the user manual and any other applicable documents, 

 compliance with the inspection and maintenance instructions for the system and its 
components. 

 

2.2 Instructions for the operator 

The product may be operated only by authorised and trained electrical engineers. An electrical 
engineer is a person who, owing to his professional education (electrical engineering), 
knowledge, experience and familiarity with the applicable standards and regulations, can 
assess the tasks assigned to him and detect possible dangers. 

In addition, the operator must have: 

 Knowledge of the technical equipment and operation of the product 

 Knowledge of the testing and measurement procedures 

 Knowledge of plant engineering (cable types, switchgear, etc.). 
 

                                                
1 Responsible body is the person or group that is responsible for the safe operation of the device and its 

maintenance (EN 61010-1, 3.5.12). 
2 Operator is the person who uses the device for its intended purpose (according to the definition of user in 

compliance with EN 61010-1, 3.5.11). 

2 FOR YOUR SAFETY 



 

 

Syscompact 4000 For your safety 

822-180-2 13 / 150 

2.3 Avoiding dangers, taking safety measures 
 When installing the test system and operating Syscompact 4000 observe the following 

rules and guidelines:  

 Accident prevention and environment protection rules applicable for your country  

 Safety instructions and regulations of the country where Syscompact 4000 is being 
used (according to the latest version) 

 EU/EFTA countries: EN 50191 Installation and operation of electric testing systems 

Other countries: The standard for installation and operation of electric testing systems 
applicable for your country 

 EU/EFTA countries: EN 50110 Operation of electric systems 

Other countries: The standard for operating electric systems applicable for your 
country 

 If necessary, other national and international standards and guidelines in accordance 
with the latest applicable version  

 Local safety and accident prevention regulations 

 Operational insurance association regulations (if any)  
 

2.3.1 Forbidden for persons with pacemakers 
 

 

 DANGER 

Magnetic and electromagnetic fields in the immediate 
surroundings of electric equipment 

It is dangerous for persons with pacemakers and metal implants to 
stand in the immediate surroundings of electric equipment. 

Magnetic and electromagnetic fields can damage and adversely affect 
the function of pacemakers and metal implants. This can be dangerous 
for the health of the concerned persons. 

 Persons with pacemakers and metal implants must not stand close 
to high-voltage systems. 

 
 

2.3.2 Operation only in a technical secure state 

Safety, function and availability depend on the proper condition of the system. 

 Operate the system and the integrated devices only in a technical perfect condition.  

 In case of damage and malfunction, immediately stop the system, mark it accordingly and 
have the faults rectified by appropriately qualified and authorised personnel.  

 Comply with the inspection and maintenance conditions. 

 Use only accessories and original spare parts recommended by BAUR. The use of spare 
parts, accessories and special facilities that are not tested and approved by BAUR could 
adversely affect the safety, function and characteristics of the product. 
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2.3.3 Checking and maintaining the safety devices 

The safety devices must be inspected regularly for proper condition and function. The system 
must not be operated in the case of defects or non-functional safety devices.  

The safety devices must not be changed, bridged or switched off.  
 

2.3.4 No operation during condensation 

Condensation can form in devices and systems due to temperature fluctuations and high air 
humidity, which in some components can result in leakage currents, flashovers and 
short-circuits.  

Maximum danger arises when relatively high air humidity and temperature fluctuations occur 
in a device consecutively, which is the case when storing the system or device in an unheated 
room or when placed outdoors, for example. When the system or device is then exposed to a 
high ambient temperature, the cold device surfaces cool the air in the immediate vicinity, which 
leads to formation of condensation even inside the device.  

During this process, two factors are crucial:  

 The higher the relative air humidity, the faster the dew point is reached and water is 
condensed.  

 The higher the temperature difference between the surfaces and the ambient air, the 
stronger the tendency for condensation.  

 Always prevent condensation in devices. Temper the device and system before and during 
the measurements so that no condensation occurs. 

 

2.3.5 No operation in areas with risk of explosion and fire 

Measurements in direct contact with water, in environments with explosive gases and in areas 
with fire risks are not permitted. Possible danger areas include e.g. chemical factories, 
refineries, paint factories, paint shops, cleaning plants, mills and stores of milled products, 
tank and loading plants for combustible gases, liquids and solid matter. 

 

2.3.6 Dangers when working with high voltage 

When performing tests and measurements with the system, dangerous - at times a very high - 
voltage is generated that is fed to the test object via an HV connection cable.  

Personnel need to pay special attention and must be very careful while working with high 
electric voltage.  

Commissioning and operation of the system are permitted only in compliance with the 
EN 50110 and EN 50191 (EU/EFTA countries) or with standards applicable in your country.  

Observe 5 safety rules 

 Comply with the following safety rules before beginning tasks in and on the electrical plant: 

1. Disconnect the test object. 

2. Secure against re-connection. 

3. Verify absence of operating voltage. 

4. Earth and short all phases. 

5. Provide protection against adjacent live parts. 
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DANGER 

High electrical voltage 

Danger to life or risk of injury due to electric shock. 

 Before commencing work, the operator must assess the risks for the 
specific working conditions. Protective measures are based on the 
risk assessment and must be followed at the workplace.  

 Connect the system as described in this user manual.  

 Pay particular attention to ensuring the test object and system are 
earthed correctly. 

 Observe the warning and safety signs on the system. Always check 
whether the warning signs are available and are legible.  

 Never put the safety devices out of operation. It is forbidden to 
bypass the safety devices. 

 Ensure that adjacent live parts are secured against accidental 
contact and flashovers with suitable covers (insulation mats, 
insulating safety plates). 

 Cordon off all metal parts in the area of the test object terminals 
(connection point and far end). Insulate and earth the metal parts to 
avoid dangerous charges. 

The test object may still be live and carry dangerous voltage after a 
measurement, even after the system or device has been switched off. 

 Before removing the safety precautions, discharge, earth and short 
circuit all live parts. 

 

   
 

 
 DANGER  

Arcing fault when establishing a connection 

Danger of burn injuries and electro-ophthalmia due to arcing fault. 

 Use suitable personal protective equipment to protect against arcing 
faults.  

 Cover the adjacent live parts with an insulating material.  

 Use only undamaged connection cables. 

 Secure the connection points and far end of the test object. 

 Use special locking devices to lock connection points. 
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2.3.7 Danger during the system’s surge mode 

 

 
 WARNING  

Potential differences between the system and the earth 

Danger to life or risk of injury due to electric shock. 

Potential differences between the system and the earth are possible 
during surge mode when the system is positioned on the cable route. 
The greatest potential difference and dangerous contact voltage will 
occur in the case of a fault due to earth contact in a plastic-insulated low 
voltage cable without shielding. 

Fault is near the system: 

Voltage drops at the fault location. There is risk of electric shock if a 
person is standing over the fault location and touches the system 
connected to the station earth.  

Fault is far away from the system: 

As the system is at the same potential as the station earth, there can be 
a voltage difference between the system and the neutral earth in the 
event of a cable fault, which can lead to rising potential of the station 
earth. There is risk of electric shock if a person touches the system 
connected to the station earth.  

 Place the system at a distance of several meters to the cable route 
or cable fault location.  

 When positioning over the cable route, do not use measurement 
methods that use a surge voltage and do not isolate the system.  

If it is not possible to avoid the hazard by means of a potential increase, 
take the following safety measures:  

 If operating in ‘surge mode’, cordon off the system at distance of at 
least 1.5 m. 

 During surge mode, people may only stand outside the cordoned off 
area. 

   

 
 

2.3.8 Dangers from road traffic 

 As tasks with systems are often carried out in the road traffic area, when assessing the 
danger also consider this danger area.  

 When setting up the system, secure the work place and during testing and measurement 
tasks, observe the country-specific road traffic regulations, applicable national work safety 
and accident prevention regulations and local conditions.  

 Moreover, dangers for the test personnel and road users must be ruled out. Test personnel 
must wear high visibility clothing that can be identified clearly by road users.  
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2.3.9 Guaranteeing immediate measures in an emergency 

The device may be operated only if a second person with visual and audio contact to the tester 
is present and is in the position to detect possible dangers and to act immediately and 
properly. 

 

2.3.10 Safety locking feature against unauthorised operation 

 When leaving the device or the system, press the emergency off button and remove the 
key. 

 Keep the key in a place that is inaccessible for unauthorised persons. 
 

2.4 Special personal protective equipment 

Personal protective equipment based on the risk assessment for the relevant working 
conditions is part of the safety concept of BAUR systems.  

 Observe the internal operating instructions and the safety instructions applicable in your 
country.  

The following safety equipment according to the state of the art can be necessary depending 
on the specific conditions in the work place:  
   

Protection against electrostatic charging, 
crushing, slipping and other accidents:  

 Safety footwear 

Protection against electric dangers (arcing fault):  Tested safety clothing 

 Insulating helmet with visor 

 Insulating protective gloves 

 NH fuse puller with cuff 

Protection against noise:  Ear protection 

Protection against dangers from road traffic:  High-visibility vest according to EN 471 
(Protection class 2) or according to the 
applicable standards in your country for 
high-visibility clothing for commercial use. 
Important: No high-visibility vests while 

working with electric arc hazard! 

Hand protection:  Safety gloves 
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3.1 Overview of the available cable fault location methods 

The following fault location methods are available to you with the Syscompact 4000 cable fault 
location system: 

Fault analysis 

 Insulation resistance measurement 

 Determining the breakdown voltage* 

 Cable testing with DC voltage* 

 Cable sheath testing* 

* This method is not supported by the BAUR system software. 

Cable fault pre-location 

 Time Domain Reflectometry (TDR) 

 Secondary-multiple impulse method (SIM/MIM) 

 Secondary-multiple impulse method used in DC mode: DC-SIM/MIM* 

 Impulse current method (ICM) 

* This method is not fully supported by the BAUR system software. 

Cable fault pin-pointing 

 Acoustic pin-pointing 

* Pin-pointing is not supported by the BAUR system software. 
   

 
 Follow the user manuals for the devices you are using for cable fault 

pin-pointing. 

   
 

3 PRODUCT INFORMATION  
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3.2 BAUR system software for cable fault location 

3.2.1 Integrated user support 

Online Help 

The Online Help includes all detailed information that you need for operating the BAUR system 
software for cable fault location. It includes the user manuals for the system and the BAUR 
system software that you already have in printed form.  

The description of all views and dialogs in the software are given exclusively in the Online 
Help. 

You can open the Online Help from the BAUR system software. Depending on the menu from 
which you invoke the Online Help, the topic on that particular dialog or view is displayed in the 
Online Help. There are many ways to invoke the Online Help:  

 If you need help on a dialog or view, press the F1 key while you are in this window.  

The Online Help opens. The help page on the corresponding topic is displayed. 

 If you need general information, in the upper menu bar, click on the Help > Help menu 
item.  

The Online Help opens. The start page of the Online Help is displayed. 

For navigation in the Online Help, you can use the table of contents (Contents tab), the index 
(Index tab) and the free text search (Search tab) on the left. 

Info icon 

Above the map or the diagrams you will find this symbol: . When you click on this icon, you 
will get a brief overview of the selected fault location methods, the measurement sequence 
and the evaluation of the measurement results. 

Tooltips 

Tooltips are short description texts that provide information on operating controls (e.g. buttons 
or settings options). Tooltips appear when you rest the mouse pointer over an element. 

 

3.2.2 BAUR GeoBase Map 

BAUR GeoBase Map makes the following information available for the operator:  

 Combination of road maps with the cable route and the BAUR cable database  

 Display of cable route and fault positions via GPS.  
 

 To acquire a license for the BAUR GeoBase Map or an update of the map material, please 
contact your BAUR representative. 

 



 

 

Product information Syscompact 4000 

20 / 150 822-180-2 

3.2.3 License terms 

All license terms for end users of the BAUR system software and BAUR GeoBase Map 
(option) are included in the BAUR end user license agreement.  

 Carefully read the end user license agreement under Help > EULA. 

This BAUR end user license agreement is legally binding between you (a natural person or 
corporate entity) and BAUR GmbH for the BAUR system software and BAUR GeoBase Map 
(option). By installing, copying or using the BAUR system software and BAUR GeoBase Map 
(option) in any other way you agree to comply with the terms of the present end user license 
agreement.  

If you do not agree to comply with the terms of this agreement, you are not authorised to use 
the BAUR system software and BAUR GeoBase Map (option). The two software products are 
subject to copyright laws and international copyright agreements as well as other laws and 
agreements on intellectual property.  

 

3.2.4 System requirements 

The BAUR system software 4 is delivered installed and ready for operation. If you would like to 
use the BAUR system software 4 on another office PC, note the system requirements below: 
   

System requirements  

Processor Min. 1 GHz (32 bit or 64 bit) 

Working memory Min. 1 GB (32 bit) or min. 2 GB (64 bit) 

Free hard disk space Min. 10 GB (32 bit or 64 bit) 

Operating system Windows 7 Ultimate 32-bit (or higher) 

Screen resolution Min. 1280 x 1024 
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3.3 Full illustration 

3.3.1 Front view 
   

 

   

No. Element Function 

1 SSG surge voltage generator Is used to generate: 

 Surge voltage 

 DC voltage 

Further information: Chapter SSG surge voltage generator (on page 
24) 

2 SA 32 SIM/MIM coupling unit Is used for the pre-location of high-resistive cable faults using the 
SIM/MIM method 

Further information: Chapter SA 32 SIM/MIM coupling unit (on page 
26) 

3 Drawer Is used to store the PC keyboard 

4 IRG 4000 time domain 
reflectometer with industrial PC 

Is used in combination with the BAUR system software for cable fault 
location 

The time domain reflectometer is operated using the BAUR system 
software. 

Further information: Chapter IRG time domain reflectometer (on page 

22) 

 Monitor Is used to display the user interface of the BAUR system software 
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No. Element Function 

5 SSG/SA HV coaxial 

connection socket 

Is used to connect the HV connection cable for measurements with the 
SSG 

Further information: Chapter "SSG/SA" HV coaxial connection socket 

(on page 30) 

6 low voltage LV coaxial 

connection socket 

Is used to connect the HV connection cable for: 

 Insulation resistance measurements 

 TDR measurements 

 Measurements with external devices of up to 2.5 kV 

Further information: Chapter "low voltage" LV coaxial connection 
socket (on page 30) 

 LV ports Are used to connect the IRG time domain reflectometer or an external 
device of up to max. 2.5 kV, e.g. audio frequency transmitter or 
ohmmeter 

7 Mains connection Is used to connect the device to the mains voltage 

Further information: Chapter Technical data (on page 37) 

8 KTG cable drum rack Is used to store, unwind and wind up the connection cables 

Further information:  

 Chapter KTG M3 cable drum rack (on page 28) 

 Chapter Connection cables to the KTG M3 cable drum rack (on 

page 29) 

9 Earth terminal Is used for clamping one of the contact sockets of the protective 
earthing cable 

  
 

3.3.2 Ports on the rear side of the system 

All of the ports on the rear side of the system are connected by the manufacturer. In order not 
to impair the system's function, do not alter any of the connections to these ports. 

 

3.4 IRG time domain reflectometer 

The IRG time domain reflectometer with an integrated transient recorder is used for 
performing measurements and recording measurement data for all pre-location methods in 
the system on 1-phase and 3-phase cables. 

When the PC is switched on, the IRG time domain reflectometer is automatically supplied with 
power. The IRG is centrally controlled via the BAUR system software. 

Further information: 

 Chapter Industrial PC (on page 23) 

 Chapter Technical data (on page 37) 
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3.5 Industrial PC 

The BAUR system software is installed on the PC that is integrated in the system. The BAUR 
system software 4 is used to perform cable fault analysis and pre-location and to control the 
IRG time domain reflectometer. 

The illustration shows a PC with an uninterruptible power supply (UPS) as an example. 

Control panel 

 
   

No. Element Function 

1 Monitor Is used to display the user interface of the BAUR system software 

The monitor is configured by the manufacturer. 

2  key Is used to switch the UPS on and off 

The PC is automatically switched on when the UPS is. 

Further information: Chapter Uninterrupted power supply (option) (on page 32) 

3 Indicator light Lights up when the UPS is switched on 

4  LED Flashes when the hard disk is accessed 

5 USB connection Is used to connect a USB cable or a USB drive 

6  LED Lights up when the IRG time domain reflectometer is switched on 

7  LED Indicates that extraneous voltage is present at the measurement input of the IRG 
time domain reflectometer 

The IRG checks whether extraneous voltage is present during: 

 Insulation resistance measurement 

 TDR measurement without voltage protection 

Further information: 

Chapter PC faults (system with UPS) (on page 133) 

Chapter PC faults (system without UPS) (on page 134) 

8 ON/OFF button 

 

Is used to switch the PC and the IRG on and off 

Important: Always shut down the PC and the IRG before switching off the 

uninterrupted power supply. 
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3.6 Insulation measuring device 

The insulation measuring device is integrated in the time domain reflectometer and is used for 
measuring the insulation resistance.  

The insulation measuring device is centrally controlled with the BAUR system software.  
   

Technical data  

Measuring voltage Max. 1,000 V 

Measurement range 0.5 Ohm – 5 GOhm 

Phase selection L-N, L-L 

   
 

3.7 SSG surge voltage generator 

The SSG surge voltage generator is used to generate surge and DC voltage of up to 32 kV for 
cable fault location on high-, medium- and low-voltage cables. 

To connect to the desired test object phase, connect the HV connection cable to the SSG/SA 
HV coaxial connection socket. You can adjust the settings and control the measurement 
sequences directly from the device control panel. 

When measurements are performed with the surge voltage generator, the test object and the 
surge voltage generator are discharged via the internal discharge unit. 

After discharge, the test object and the surge voltage generator are earthed via the earthing 
device of the SA 32 SIM/MIM coupling unit. 

Control panel 
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No. Element Function 

1 Selector switch for surge voltage 
range 

Is used to select a surge voltage range 

2 On/Off switch Is used to switch the surge voltage generator on and off 

3  button Puts the surge voltage generator in the Ready to switch on operating 
state 

  key Puts the surge voltage generator in the In operation operating state 

  button Deactivates the high voltage release, activates the internal 
discharge units and puts the surge voltage generator in the Ready 
for operation operating state 

4 Voltage indicator Displays the actual voltage 

5  key Is used to release a single surge 

6 imp/min selector switch Is used to set the surge sequence or to select the DC voltage: 

  : Rapid surge sequence 

  : Slow surge sequence 

  : No surge sequence 

The switch must be in this position so that a single surge can be 

released using the  key. 

  : DC voltage operation 

NOTICE! If, when switching to DC voltage operation, the surge 
capacitor of the SSG is live, this can lead to erosion on the 
short-circuit contacts within the device. 

 Before switching to DC voltage operation, rotate the  rotary 
switch all the way to the left. 

7 Indicator lights Indicate the system operating state: 

 Green: Ready for operation 

 Red: Ready to switch on, In operation 

8 Emergency off button Moves the system to the Ready for operation operating state. 

The emergency off button is equipped with a key lock to protect 
against restart, unauthorised start-up, and unauthorised or 
unintentional operation. 

9  rotary knob Is used to set the output voltage 

10 Fuses F3 + F4 Is used to protect the control unit: 

 of the solenoids of the surge voltage generator 

 of the solenoid of the SIM/MIM coupling unit 

Fuses: time lag, 3.15 A 
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No. Element Function 

11 Overcurrent protection switch I > Switches the surge voltage generator off in the event of overload 

The overcurrent protection switch is triggered both thermally and 
magnetically. 

   

Technical data 
   

Technical data    

 SSG 1100 SSG 1500* SSG 2100* 

Surge voltage ranges 0 – 8 kV 

0 – 16 kV 

0 – 32 kV 

0 – 8 kV 

0 – 16 kV 

0 – 32 kV 

0 – 8 kV 

0 – 16 kV 

0 – 32 kV 

Surge sequence 10 or 20 pulses/min, single 
surge 

20 or 30 pulses/min, single 
surge 

10 or 20 pulses/min, single 
surge 

Surge energy 1,100 J 
@ 8 / 16 / 32 kV 

1,540 J 
@ 8 / 16 / 32 kV 

2,050 J 
@ 8 / 16 / 32 kV 

Charging capacitance 4 x 8.6 µF 4 x 12 µF 4 x 16 µF 

DC voltage 0 – 32 kV 0 – 32 kV 0 – 32 kV 

Max. output current (in DC voltage operation) depending upon surge voltage range 

0 – 8 kV: 560 mA 850 mA 850 mA 

0 – 16 kV: 280 mA 425 mA 425 mA 

0 – 32 kV: 140 mA 210 mA 210 mA 

   

* Option instead of SSG 1100 
 

3.8 SA 32 SIM/MIM coupling unit 

The SA 32 SIM/MIM coupling unit is used for the pre-location of high-resistive cable faults 
using the SIM/MIM method. 

The SA 32 SIM/MIM coupling unit also offers the option of performing cable and cable sheath 
testing if the surge voltage generator is operated in DC mode. 

Control panel 
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No. Element Function 

1 Indicator light SIM Lights up when a measurement using the SIM/MIM method is underway 

2 Selector switch for 
the sensitivity of the 
current indicator 

Is used to set the sensitivity of the current indicator 

Positions: x1, x10, x100 

3 Current indicator Shows the actual current during the cable or cable sheath test 

4 Drawbar test|SSG Is used to select between the fault location methods with surge voltage and cable 
testing with DC voltage 

 Drawbar pushed in: Is used for fault location methods with surge voltage 

 Drawbar pulled out: Is used for cable tests with DC voltage. The current 
indicator is activated. 

5 Drawbar SA 32|SSG  Drawbar pushed in: The SIM/MIM coupling unit is deactivated. The 
measurement is performed with the SSG surge voltage generator. 

 Drawbar pulled out: The SIM/MIM coupling unit is active. A measurement can 
be performed according to the SIM/MIM method. 

   

Overview of the positions of drawbars for various applications 
   

Application Drawbar test|SSG Drawbar SA 32|SSG 

Impulse current method (ICM) pushed in pushed in 

Acoustic pin-pointing pushed in pushed in 

Secondary-multiple impulse method (SIM/MIM) pushed in pulled out 

Cable testing with DC voltage pulled out pushed in 

   

Further information: 

 Chapter Cable and cable sheath testing (on page 84) 

 Chapter Cable fault pre-location (on page 88) 

 Chapter Cable fault pin-pointing (on page 110) 
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3.9 KTG M3 cable drum rack 

The KTG M3 cable drum rack is permanently mounted on the Syscompact 4000 and is used to 
store, unwind and wind up the connection cables. 

Use the cable drum rack only with the supplied cables or with cables of same specification. 
   

 

   

No. Element Function 

1 Earth terminal Is used for clamping one of the contact sockets of the protective earthing 
cable 

2 Port for the external 
emergency off unit (option) 

Is used to connect an external emergency off unit 

If no external emergency off unit is being used, this port is bridged with a 
bypass plug. 

3 Cable guide clamp Is used for proper guiding of the connection cables 

4 SSG/SA HV coaxial 

connection socket 

Is used to connect the HV connection cable for measurements with the 
SSG 

Further information: Chapter "SSG/SA" HV coaxial connection socket 

(on page 30) 
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No. Element Function 

5 low voltage LV coaxial 

connection socket 

Is used to connect the HV connection cable for: 

 Insulation resistance measurements 

 TDR measurements 

Measurements with external devices of up to 2.5 kV 

Further information: Chapter "low voltage" LV coaxial connection socket 
(on page 30) 

 LV ports Are used to connect the IRG time domain reflectometer or an external 
device of up to max. 2.5 kV, e.g. audio frequency transmitter or 
ohmmeter 

6 Mains connection Is used to connect the device to the mains voltage 

Further information: Chapter Technical data (on page 37) 

7 Cable drum Is used to store the connection cables 

Further information on the connection cables: Chapter Connection 
cables to the KTG M3 cable drum rack (on page 29) 

8 Uncoiling brake for cable 
drum 

Is used to fix the cable drum and to prevent unintentional unwinding of 
the connection cable 

   

Further information on operating the cable drum rack: Chapter Unwinding and winding up the 
connection cables  (on page 38) 

 

3.10 Connection cables to the KTG M3 cable drum rack 
   

Cable Function 
Minimum bending 
radius 

HV connection cable with HV plug, 
nominal voltage (DC) 80 kV 

Is used to connect to the test object 100 mm 

Mains supply cord, 3 x 4 mm2, 32 A 
CEE plug 

Is used to connect the system to the mains 
voltage  

75 mm 

Protective earthing cable, 16 mm2 Is used to connect the system to the protective 
earthing 

75 mm 
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3.11 "SSG/SA" HV coaxial connection socket 

The HV coaxial connection socket is used to connect the HV connection cables for 
measurements with the SSG. 

The HV coaxial connection socket is equipped with a microswitch that prevents the system 
from being put into the Ready to switch on operating state when the HV connection cable is not 
connected correctly. 
   

 

   
 

3.12 "low voltage" LV coaxial connection socket 

The LV coaxial connection socket is used to connect the HV connection cables for: 

 the insulation resistance measurement 

 the TDR measurement 

 measurements with external devices of up to max. 2.5 kV 

The LV coaxial connection socket is equipped with two LV ports that can be connected to an 
external device, e.g. an audio frequency transmitter or insulation measuring device with an 
output voltage of up to max. 2.5 kV (max. current 24 A). 
   

 

   
 

3.13 Safety devices  

3.13.1 Discharge and earthing device 

The SSG surge voltage generator has an integrated discharge unit. The SA 32 SIM/MIM 
coupling unit has an integrated earthing device. 

Once the HV has been switched off using the  key or by pressing the emergency off button, 
the SSG and the test object are discharged and earthed. The system status changes to the 
Ready for operation operating state and the green indicator light on the SSG illuminates. 



 

 

Syscompact 4000 Product information 

822-180-2 31 / 150 

The discharge and earthing device is also automatically activated when the microswitch of the 
HV coaxial connection socket is opened or the system is disconnected from the mains voltage. 

Discharging, earthing and short-circuiting the test object 

Even if the test object and the HV system components have been discharged, the test object 
can still carry dangerous voltage. Cables have a capacitance and can continue to hold a 
charge even after switching off the surge voltage generator or can be recharged after a 
temporary short-circuit due to recurring voltages.  

 Before touching the test object, discharge, earth and short it: at the connection point and at 
the far end. 

 You may touch the plant parts that were under voltage only if they are visibly earthed and 
short-circuited. 

 

3.13.2 Calculating the minimum discharge time 

The minimum discharge time for the surge capacitor of the SSG and the test object is 
calculated thus: 5 x R x (Ci + Cp). 
   

R Discharging resistance 

Ci Capacitance of surge capacitor 

Cp Capacitance of test object 
   
   

 SSG 1100 SSG 1500* SSG 2100* 

Capacitance of surge capacitor Ci    

8 kV position: 34.4 µF 48 µF 64 µF 

16 kV position: 8.6 µF 12 µF 16 µF 

32 kV position: 2.15 µF 3 µF 4 µF 

Discharging resistance of the SSG    

for the surge capacitor: 16.5 kOhm 16.5 kOhm 16.5 kOhm 

for the test object: 16.5 kOhm 16.5 kOhm 16.5 kOhm 

   

* Option instead of SSG 1100 

Recommended discharge and earth rod (option): 
   

GDR 40-250  

Max. permissible voltage 40 kV 

Max. permissible discharge energy 600 J 

Discharging resistance 250 kOhm 

Time between two discharges 10 min 

   
 



 

 

Product information Syscompact 4000 

32 / 150 822-180-2 

3.13.3 Emergency off button 

The emergency off button is located on the front panel of the SSG surge voltage generator and 
is equipped with key and lock for protection against unauthorised or unintentional operation.  

 In the event of danger, immediately press the emergency off button on the SSG surge 
voltage generator. 

   

 

   

 The SSG is switched off. 

 The SSG and the test object are discharged and short-circuited against the protective 
earth. 

Note: The test object is not automatically disconnected from the system. You must 
disconnect the test object from the system yourself. 

 The system status changes to the Ready for operation operating state and the green 
indicator light on the SSG illuminates. 

 To operate the system again after pressing the emergency off button, unlock the 
emergency off button. 

 

3.13.4 Microswitch monitoring for measurements using the "SSG/SA" HV 
coaxial connection socket  

The HV coaxial connection socket is equipped with a microswitch that prevents the system 
from being put into the Ready to switch on operating state when the HV connection cable is not 
connected correctly. 

If the HV connection cable is not connected securely enough, the power supply of the 
SIM/MIM coupling unit and the SSG surge voltage generator will be interrupted. The SSG and 
the test object will be discharged and short-circuited. 

 

3.14 Power supply 

The system can be supplied with power via an existing mains supply on site. 

Permissible supply voltage: 220 – 230 V, 50/60 Hz 

Depending upon the configuration of the system, you can connect external devices to the 
supply voltage via an optional safety contact socket. 

 

3.14.1 Mains voltage supply 

The mains voltage supply is provided via a mains supply cord (3 x 4 mm2) that is wound up on 
a cable drum. If necessary, use a country-specific adapter. 

 

3.14.2 Uninterrupted power supply (option) 

The system may be optionally equipped with a 500 VA uninterruptible power supply (UPS). 

If the mains voltage falls below a defined voltage value, the UPS takes over the power supply 
to the PC, the monitor and the IRG time domain reflectometer. After a power failure, the PC 
remains on for approx. 10 min. 

 To switch on the UPS, press the  key next to the PC monitor. 

The PC is switched on automatically. 
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Technical data 

Output power 300 W / 500 VA 

Output voltage AC 230 V 

Output frequency 47 - 63 Hz  

Input voltage AC 230 V 

Input frequency 47 - 63 Hz  

Battery type Maintenance-free, sealed lead battery with suspended electrolyte, leak-proof 

   
 

3.15 Operating states of the system 

3.15.1 “Out of operation” operating state 

 All safety measures necessary before stepping into the test area have been met. 

 All power supplies, signal and control electric circuits are switched off. 
 

3.15.2 “Ready for operation” operating state  

 The safety measures of the Out of operation operating state that are necessary before 
stepping into the danger area are still in place.  

 The power supplies for the signal and control current circuits of the switching devices are 
switched on. 

 The test voltage supply is switched off and secured against accidental start. 

 The green indicator light on the SSG surge voltage generator comes on. 

Procedure 

 To put the system into the Ready for operation operating state, switch on the SSG surge 
voltage generator using the On/Off switch. 

   

 

   

 To put the system back into the Ready for operation operating state after a measurement, 

deactivate the high voltage release. To do this, press the  key on the SSG surge 
voltage generator. 
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3.15.3 “Ready to switch on” operating state 

 All accesses to the test area are closed. The safety measures of the Out of operation 
operating state that are necessary before stepping into the danger area are lifted. 

 The test voltage supply is switched off. 

 The red indicator light on the surge voltage generator comes on. 

Procedure 

 To switch the system to the Ready to switch on operating state, release the high voltage on 

the SSG surge voltage generator. To do this, press the  key on the surge voltage 
generator. 

   

 

   
 

3.15.4 “In operation” operating state 

 All accesses to the test area are closed. 

 The system is in the Ready to switch on operating state. 

 One or more test voltage supplies are switched on. 

 The red indicator light on the surge voltage generator comes on. 

 The  key illuminates. 

Procedure 

 To switch the system to the In operation operating state, switch on the high voltage. To do 

this, press the  key on the SSG surge voltage generator. 
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3.16 Safety and information signs 

Warning sign about high voltage on the SSG surge voltage generator 
   

 
   

Information sign about the correct switching off sequence for systems with UPS 
   

 
   

Symbols on ports and connection cables 
   

Symbol Description 

 
 Warns against high electrical voltage and a possible risk of electric shock 

 Indicates the HV connection cable 

 
General warning sign 

Indicates that there is a potential risk of danger when using the product and hence the user manual 
must be observed 

 
Indicates the screen of the HV connection cable that is connected to the station earth of the test 
object as the operational earthing 

 
Indicates the protective earthing cable 
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Rating plates 
   

SSG surge voltage generator IRG 4000 time domain 
reflectometer 

SA 32 SIM/MIM coupling unit 

   
   

Element Description 

Type Device designation 

Nr. Serial number 

U Supply voltage 

If several supply voltages are possible, these are given consecutively one 
after another. 

 Not applicable here 

f Mains frequency 

VA Max. recorded apparent output 

 On the IRG 4000: 600 VA 

 On the SA 32: 80 VA 

0 – 32 kV (on the SSG) Max. surge voltage range of the SSG 

U DC max. 32 Kv (on the SA 32) Max. DC output voltage of the SA 32 

 General warning sign 

Indicates that there is a potential risk of danger when using the product 
and hence the user manual must be observed 

 
CE mark 

Indicates that the device or system conforms to CE. 

BAUR GmbH 

6832 Sulz / Austria  

Name and address of the manufacturer 

Made in Austria Indicates the country in which the device was manufactured. 
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4 TECHNICAL DATA 
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The procedure is described for KTG M type of cable drum racks as example. 
 

5.1 Unwinding the connection cable from the KTG M cable drum 
1. Make sure that the connection cable is not connected anywhere. Otherwise you cannot 

unwind the cable.  

2. Pull the connection cable plug from its holder. 

Leave the plugs of the connection cables you don’t need in their holders. 

3. Release the uncoiling brake on the cable drum you want: To do this, turn the appropriate 
brake lever anti-clockwise (approx. half a turn, do not turn fully). 

 

 

 

4. Unwind the connection cable to the desired length.  

Guide the connection cable through the cable guide clamp. This arranges the cable in 
such a way that on closing the rear doors of the cable test van, it goes into the cable outlet 
and does not get jammed. 

5. Attach the uncoiling brake to the cable drum: To do this, turn the brake lever clockwise. 

 

 

 

This prevents the cable from unwinding unintentionally. 
 

5 UNWINDING AND WINDING UP THE CONNECTION CABLES  
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5.2 Winding up the connection cable on the KTG M cable drum 

Prerequisite 

The connection cable is voltage-free. 

Further information: 

 Chapter Ensuring there is no voltage at the work place (on page 42) 

 Chapter Discharging and earthing the test object (on page 118) 

Procedure 

1. Disconnect the connection cables and lay them straight without loops. Make sure that the 
connection cables do not drag over sharp objects. 

2. Check the connection cables for cracks, damage and any dirt. 

3. If dirty, clean the connection cables with a lint-free cloth. 

4. Remove the connection cables from the cable guide clamp. 

5. Release the uncoiling brake on the cable drum you want: To do this, turn the appropriate 
brake lever anti-clockwise (approx. half a turn, do not turn fully). 

 

 

 

6. Wind up the connection cable manually.  

7. Ensure that the connection cable is distributed evenly on the cable drum.  

8. Once the connection cable has been wound up, attach the uncoiling brake to the cable 
drum: To do this, turn the brake lever clockwise.    

 

 

 

This prevents the connection cable from unwinding unintentionally.  

9. Place the plugs of the connection cables in their holders on the cable drum rack. 
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1. Operate the system only in a technical perfect condition. 

2. Check the system and mechanical connections for damage. 

3. Check other devices for damage that are not integrated in the system and that you intend 
to use. 

4. Check electrical connections and connection cables for damage.  

Use only undamaged connection cables. 

5. Check the safety devices regularly for proper condition and function. 

This particularly applies for signal systems, emergency off units, earthing and short-circuit 
devices and ports. 

 

6 CHECKS TO PERFORM BEFORE COMMISSIONING 
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Follow the information below: 

 The safety instructions in the chapter For your safety (on page 12) 

 Local safety and accident prevention regulations 

 Safety instructions and regulations according to the state-of-the-art 

 National and international standards and guidelines in the latest applicable version: 

EN 50110 for the operation of electrical installations (EU/EFTA countries);  

EN 50191 for the erection and operation of electrical test installations (EU/EFTA 
countries)  

or applicable standards in your country. 

 Employers’ liability insurance association regulations (if any)  

 Use appropriate personal protective equipment (PPE) for protection against electric shock 
and burning due to possible arcing faults in compliance with the local work safety and 
accident prevention regulations.  

 

7.1 Setting up the system 
   

 
 WARNING 

Potential differences between the system and the earth possible 

Danger to life or risk of injury due to electric shock. 

If a cable fault is located near to the system, there may be potential 
differences between the system and the earth in surge mode.  

 Place the system at a distance of several meters to the cable route 
or cable fault location.  

 If operating in ‘surge mode’, cordon off the system at distance of at 
least 1.5 m.  

During surge mode, people may only stand outside the cordoned off 
area. 

 Before starting surge mode, check the cable route for potential 
dangers. 

   

 Select the installation location for the system in such a way that 

 A stable base is guaranteed and the system cannot tip over, 

 The system is easy to access for the connections and operation. 

 sufficient safety distances are maintained. In this regard, comply with EN 50110 for 
operation of electric systems (EU/EFTA countries) or the relevant standards 
applicable in your country. 

 

7 CONNECTING THE SYSTEM  
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7.1.1 Placing the system in the road traffic area 

When placing the system in the road traffic area:  

 Wear a high visibility vest so that road users can recognise you better. 

 Position the system as far away from the moving traffic as possible. 

 Secure the work place in compliance with the applicable national work safety and accident 
prevention regulations as well as local conditions. 

 

7.2 Ensuring there is no voltage at the work place 

Before connecting the test object follow the 5 safety rules: 

1. Disconnect the test object. 

2. Secure against re-connection. 

3. Verify absence of operating voltage. 

4. Provide protection against adjacent live parts.  

5. Earth and short all phases. 

Note: 

 If the cable sheath is not earthed, establish a short earth connection to the station earth. 
The station earth is the neutral point of the earth connections. 

 The earthing conductor should be as short as possible and show low impedance. Use a 
copper earthing conductor with a cross-section of min. 16 mm2. 

 
 

7.3 Preparing the test object terminals 

The test object terminals are the connection point and the far end of the test object. 

1. Disconnect all operating resources that are connected to the test object and are not 
designed for the stipulated test voltage. 

2. Cordon off all metal parts, e.g. lighting masts at the test object terminals or insulate them 
with insulating safety plates.  

3. Earth all metal parts at the terminals to avoid dangerous charging.  

4. All cables that are used in danger zones can also carry high voltage potential outwards. 
Therefore, remove these cables from the danger zone or ensure low-resistive earthing and 
short-circuit.  

5. Follow the cable line and ensure that no work is being carried out underground on gas 
lines and that there are no other danger points. 
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7.4 Connecting the test object 

7.4.1 Safety instructions 
   

 
 WARNING  

Danger due to electric voltage, flashovers at the connection point, 
or arcing fault on connection 

Electric shock on touching live and active parts and due to residual 
charges and induction voltages;  

Burns, electro-ophthalmia, hearing damage.  

 Use suitable personal protective equipment against electric shocks 
and arcing faults. 

 Observe the phase breaks. 

 Ensure that adjacent live parts are secured against accidental 
contact and flashovers with suitable covers (insulation mats, 
insulating safety plates). 

 You may touch the parts that were under voltage only if they are 
visibly earthed and short-circuited. 

   
 

7.4.2 Various connection options for cable fault location 

Depending on the measurement method, select the right connection option: 
   

 Cable fault analysis: 

Chapter Connecting the HV connection cable to a phase of the test 
object (on page 43) 

 Cable fault location: 

 Cable testing: 

 Acoustic pin-pointing: 

Cable sheath testing: 
Chapter Connecting the HV connection cable to the test object 
screen (on page 48) 

   
 

7.4.3 Connecting the HV connection cable to a phase of the test object 

Two connection sockets are available on the system for connecting the HV connection cable: 

 SSG/SA: For measurements with the SSG 

 low voltage: For insulation resistance measurements, TDR measurements and 
measurements with external devices of up to 2.5 kV (LV) 

Prerequisites 

 The workplace must be disconnected from the power supply. 

 The connection points and far end are prepared for the measurement. 

 The protective earthing cable of the earth rod is connected to the station earth. 
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Further information: 

 Chapter Ensuring there is no voltage at the work place (on page 42) 

 Chapter Preparing the test object terminals (on page 42) 

Connection diagram 

 Measurement with LV: Cable with shielded phases (on page 45) 

 Measurement with the SSG: Cable with shielded phases (on page 46) 

 Measurement with the SSG: Unscreened cable with 3 phases (on page 47) 

 Measurement with the SSG: Acoustic pin-pointing of cable breaks (on page 48) 

Procedure 

The following description is an example for how to connect the system to a 3-phase test object. 
Connecting the system to a 1-phase test object is similar. 

1. Unwind the protective earthing cable to the required length. 

2. Connect the protective earthing cable to the station earth - as close as possible to the 
station earth connection. 

3. Clamp one of the contact sockets of the protective earthing cable to the earthing terminal 
on the cable drum rack. 

When doing so, ensure that the connection between the connection point of the protective 
earthing cable and the earth terminal is as short as possible. 

4. The HV connection cable screen is used for the operational earthing. The operational 
earthing closes the electric circuit and is used for the return cable of the impulse current. It 
is therefore particularly important for the operational earthing port to be connected properly 
to the correct connection point. 

Connect the screen of the HV connection cable to the station earth. Select the location for 
connecting the screen to the station earth as follows: 

 as close as possible to the location where the cable screens of the test object phases 
are connected to the station earth, and 

 as close as possible to the location where the test object phases are connected to the 
station earth. 

5. Connect the HV connection cable to the test object phase to test. Proceed as follows:  

a. Unwind the HV connection cable to the required length. 

b. Connect the HV connection cable to the test object phase to test. 

Measurement with LV: 

c. Connect the system HV connection cable to the low voltage LV coaxial connection 
socket. 

d. For the insulation resistance and TDR measurement, connect the connection cables 
of the IRG to the LV ports. 

   

 

   

If an external device is to be used for the measurement, connect the external device to 
the LV ports. Further information: Chapter Connecting an external device to the 
system (on page 50) 
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Measurement with SSG: 

 Connect the system HV connection cable to the SSG/SA HV coaxial connection 
socket. 

6. Remove the earthing and the short-circuit connection from the phase to be tested at the 
connection point and at the far end. 

7. Make sure that the phases not being tested are earthed and shorted. 

8. Make sure that the jumper plug on the cable drum rack is inserted in the port for the 
external emergency off unit. 

Locating cable breaks 

In the event of cable breaks in the 1-phase cable: 

 Short the faulty phase with the screen and with the station earth at the far end. 

In the event of cable breaks in the multi-phase cable: 

 Short all phases with the screen and with the station earth at the far end. 
 

Measurement with LV: Cable with shielded phases 

This connection diagram applies for: 

 Insulation resistance measurements 

 TDR measurements 

 Measurements with external devices of up to max. 2.5 kV 

The illustration shows an example of a connection diagram with a 3-phase test object. 
Connecting the system to a 1-phase test object is similar. 
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Measurement with the SSG: Cable with shielded phases 

The illustration shows an example of a connection diagram with a 3-phase test object. 
Connecting the system to a 1-phase test object is similar. 
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Measurement with the SSG: Unscreened cable with 3 phases 

The illustration shows an example of a connection diagram with a 3-phase test object. 
Connecting the system to a 1-phase test object is similar. 
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Measurement with the SSG: Acoustic pin-pointing of cable breaks 
   

 
   

 

7.4.4 Connecting the HV connection cable to the test object screen 

This connection option applies for the cable sheath testing. 

Prerequisites 

 The workplace must be disconnected from the power supply. 

 The connection points and far end are prepared for the measurement. 

 The protective earthing cable of the earth rod is connected to the station earth. 

Further information: 

 Chapter Ensuring there is no voltage at the work place (on page 42) 

 Chapter Preparing the test object terminals (on page 42) 
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Procedure 

The following description and the illustration are examples for how to connect the system to a 
3-phase test object. Connecting the system to a 1-phase test object is similar. 
   

 
   

1. Unwind the protective earthing cable to the required length. 

2. Connect the protective earthing cable to the station earth - as close as possible to the 
station earth connection. 

3. Clamp one of the contact sockets of the protective earthing cable to the earthing terminal 
on the cable drum rack. 

When doing so, ensure that the connection between the connection point of the protective 
earthing cable and the earth terminal is as short as possible. 

4. The HV connection cable screen is used for the operational earthing. The operational 
earthing closes the electric circuit and is used for the return cable of the impulse current. It 
is therefore particularly important for the operational earthing port to be connected properly 
to the correct connection point. 

Connect the screen of the HV connection cable to the station earth. Select the location for 
connecting the screen to the station earth as follows: 

 as close as possible to the location where the cable screens of the test object phases 
are connected to the station earth, and 

 as close as possible to the location where the test object phases are connected to the 
station earth. 

5. Make sure that the screens of all phases of the test object are disconnected from the 
station earth at both ends: at the connection point and at the far end. 
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6. Connect the HV connection cable to the screen of the test object phase to test. Proceed as 
follows:  

a. Unwind the HV connection cable to the required length. 

b. Connect the HV connection cable to the screen of the test object phase to test.  

c. Connect the system HV connection cable to the SSG/SA HV coaxial connection 
socket. 

7. Make sure that the phases not being tested are earthed and shorted. 

8. Make sure that the jumper plug on the cable drum rack is inserted in the port for the 
external emergency off unit. 

 

7.4.5 Connecting an external device to the system 

There are two LV ports on the low voltage LV coaxial connection socket. You can use these LV 
ports to connect e.g. an external insulation measuring device or an audio frequency 
transmitter. The LV ports are designed for external devices of up to 2.5 kV. 

Connection example for TG 20/50 

An external insulation measuring device is connected as illustrated for the TG 20/50.  
   

 

   

1. Connect the external device to the low voltage LV coaxial connection socket on the LV 
ports (see image). 

2. Connect the external device to a suitable power supply (if needed). 

The measurements with the external devices that are connected to the LV ports are performed 
via the system's HV connection cable. Further information on connecting the HV connection 
cable: Chapter Connecting the HV connection cable to a phase of the test object (on page 43) 

 

7.5 Connecting the system to the supply voltage 
1. Measure the mains voltage with a voltmeter. 

2. Compare the mains voltage with the specifications in the technical data for the system. 

Further information: Chapter Technical data (on page 37) 
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3. Make sure that the mains supply earth is not isolated from the station earth. 

 CAUTION  

High electric voltage through potential increase. Risk of personal injury due to electric 
shock. Damage to property due to potential differences from mains input to the housing. 

4. Pull the plug of the mains supply cord from its holder. 

5. Release the uncoiling brake on the cable drum: To do this, turn the appropriate brake lever 
anti-clockwise.  

6. Unwind the mains supply cord to the required length. 

7. Connect the system to the mains voltage. If necessary, use a country-specific adapter.  

If you have only one mains port via the SCHUKO® power socket, use an adapter with the 
SCHUKO® 16 A plug type (option). 

8. Connect the plug on the mains supply cord cable drum to the coupler socket on the 
system. 

The figure is illustrative. 

   

 

   
 

7.6 Securing the test area 
1. Mark out the path for pedestrians.  

2. Protect the test lead (connection cable), e.g. with cable bridges or rubber mats. The cables 
must be protected against damage and there must be no danger of people tripping. 

3. If the connection creates a hazard for the testing personnel and pedestrians, mark them.  

4. The area around the test structure (test area) must be demarcated from workplaces and 
traffic in such a way that  

 except for the tester, no other person can remain in the test area, 

 except for the tester, no other person can access the test area, 

 persons standing outside the boundary cannot reach the operating elements of the 
test system located inside the boundary. (EN 50191) 

The minimum height of individual boundaries must be 1 m.  

5. If the system is cordoned off from general areas only with ropes, chains or bars, the entire 
test structure must be monitored during the test in compliance with EN 50191. If the test 
structure includes several local test areas, security guards must be appointed for each test 
area. But it is important that the testing personnel and the security guards understand each 
other well. 

6. Mark the test area and terminals clearly. It must be very obvious that a cable test is in 
progress.  

7. Make sure that unauthorised persons cannot access the local mains stations.   
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Follow the information below: 

 The safety instructions in the chapter For your safety (on page 12) 

 Local safety and accident prevention regulations 

 Safety instructions and regulations according to the state-of-the-art 

 National and international standards and guidelines in the latest applicable version: 

EN 50110 for the operation of electrical installations (EU/EFTA countries);  

EN 50191 for the erection and operation of electrical test installations (EU/EFTA countries)  

or applicable standards in your country. 

 Employers’ liability insurance association regulations (if any)  
 

8.1 Safety instructions 
 

 
 WARNING  

Residual voltage in test object 

Danger to life, risk of injury due to electric shock. 

Cables have a capacitance and can continue to carry load even after 
switching off the HV generator or can be recharged after a temporary 
short-circuit due to recurring voltages.  

 Before touching the test object, discharge, earth and short it: at the 
connection point and at the far end. 

 You may touch the plant parts that were under voltage only if they 
are visibly earthed and short-circuited. 

 

 
 

8 COMMISSIONING 
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8.2 Switching on the system and starting the BAUR system 
software 

Prerequisites 

 The system is earthed correctly. 

 The test object is connected properly. 

 The system is connected to the appropriate supply voltage. 

Further information: Chapter Connecting the system to the supply voltage (on page 50) 

Procedure 

1. Switch on the SSG surge voltage generator using the On/Off switch. 

 

 

 

 The system status changes to the Ready for operation operating state. 

 The green indicator light comes on. 

2. Switch the PC on: 

Systems with UPS 

 Switch the UPS on with the  key next to the PC monitor. 

The PC is switched on automatically. 

Systems without UPS 

 Switch the PC on with the  On/Off key. 

3. To start the BAUR system software, select it from the program list in Windows. 

Alternatively, double-click on the shortcut icon for the BAUR system software on the 
desktop. The system software opens. 

Further information on performing measurements and various fault location methods: 

 Chapter Cable fault analysis (on page 77) 

 Chapter Cable and cable sheath testing (on page 84) 

 Chapter Cable fault pre-location (on page 88) 

 Chapter Cable fault pin-pointing (on page 110) 
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9.1 Login 

Rights of individual users can be set up with the user login administration. If you don’t need the 
user and rights administration, you can disable the login message. 

 

9.1.1 User roles and rights 

There are two user roles: Engineer or Administrator. The difference between the two roles is 
the ability to define voltages per measurement method and nominal voltage and to create 
users. All other functions are available for every user.  

The Service role is automatically assigned to BAUR After Sales and cannot be managed.  

Overview of available user roles and their rights 
 

Role Rights 

Administrator All functions of the BAUR system software, including the additional Administrator rights: 

 User administration: Create new users, assign rights, enable and disable login 

 Define the threshold values for various fault types during the insulation resistance 
measurement 

 Define the max. permissible voltage, the recommended voltage and other voltage 
details per method and nominal voltage 

Engineer All functions of the BAUR system software, except the additional Administrator rights 

Service This role is assigned to BAUR After Sales. 

 
 

9.1.2 Creating users 

Prerequisite 

You have Administrator rights for the BAUR system software. 

Procedure 

1. In the Tools menu, select the Settings menu item. 

2. In the Settings dialog, select the User management tab. 

3. Click the Add new user button. 

In the list of users, a new user is displayed with an automatically generated name.  

4. To define the name and rights of the new user, in the list, click on the new user and click on 

the  icon. 

A dialog to define the new user opens.  

5. Enter the user name and password.  

9 OPERATING AND CONFIGURING THE BAUR  SYSTEM 

SOFTWARE 



 

 

Syscompact 4000 Operating and configuring the BAUR system software 

822-180-2 55 / 150 

6. Confirm the password by re-entering it. 

7. Note down this password and store it in a safe place.  

8. In the Available user roles area, click on a role that you want to assign to the new user.  

9. To apply this role, click the  button. 

The applied role is displayed in the User roles area. 

10. If you want to take away a role assigned to the user, click the  button. 

The role is removed from the User roles area. 

11. Click the OK button to confirm the entries. 
 

9.1.3 Changing the user properties 

Prerequisite 

You have Administrator rights for the BAUR system software. 

Procedure 

1. To change the name, password or rights of a user, click on the  icon of the respective 
user. 

A dialog to define the user opens. The roles assigned to the user are displayed in the User 
roles area. 

2. You can change the name and/or password of the user as required. 

3. If you want to assign a role to the user, in the Available user roles area click on the 

respective role and click the  button. 

The applied role is displayed in the User roles area. 

4. If you want to take away a role assigned to the user, click the  button. 

The role is removed from the User roles area. 

5. Click the OK button to confirm the entries. 
 

9.1.4 Enabling Login 

Prerequisite 

You have Administrator rights for the BAUR system software. 

Procedure 

1. In the Tools menu, select the Settings menu item. 

2. In the Settings dialog, select the User management tab. 

3. In the lower area of the dialog, enable the Display login dialog checkbox. 

The next time you start the BAUR system software, you will be prompted for the Login 
information.  

 

9.1.5 Logging into the system 

If the Login checkbox is enabled, on starting the software, the Login dialog is displayed.  

1. Enter your user name and password.  

If you have forgotten your Login information, contact your BAUR representative 
(http://www.baur.eu/baur-worldwide). 

2. Click the Login button. 
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9.2 Operation of the BAUR system software for cable fault 
location 

9.2.1 Key combinations 

You can use various key combinations for quick navigation in the software. 
   

Key/Key combination Function 

F1 Opens the Online Help 

F11 Opens and closes the Full screen view 

Ctrl - Zooms out the view 

Ctrl + Zooms in the view 

Ctrl+O Opens the Select cable route dialog 

In this dialog, you can search for cable routes, select cable routes or delete 
cable routes. 

   
 

9.2.2 Evaluating reflection images 

Performing measurements as part of the cable fault pre-location produces so-called reflection 
images. These reflection images make it easier to locate cable faults. In addition to these 
images, you can evaluate the reflection images in detail (with cursors and context menus in 
the reflection images). 

Evaluation with cursors 

Cursors are available for evaluating the reflection images. Cursors enable you to mark fault 
and joint positions precisely or to measure distances and fault distances. 

You can identify the cursor type by the cursor flag. 
 

Cursor flag Cursor name Meaning 

 End of cable route Displays the automatically detected end of cable route 

If the software detects a big positive reflection after a TDR or 
SIM/MIM measurement, it interprets this reflection as the cable end 
and automatically sets the End of cable route cursor after the 
measurement. In the cursor flag, you can see after how many meters 
or feet the end of the cable route was detected. 

 Compare this value with the cable length known to you and if 
needed, adjust the cable length or velocity of propagation. 
Further information: Adjusting the cable length and velocity of 
propagation (on page 94) 

 Cable fault Displays the position where a possible fault was detected 
automatically 

If the software detects a possible fault position in the reflection image, 
after the measurement, the Cable fault cursor is set automatically. In 

the cursor flag, you can see after how many meters or feet 
(measured from the start of the cable route) the fault was detected. 
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Cursor flag Cursor name Meaning 

 Start of cable 
route 

Displays the original start of the cable route 

This cursor is only displayed when a trace has been moved. In the 
cursor flag, you can see by how many meters or feet the start of the 
cable route has been moved. 

 Info cursor Displays a manually set cursor 

 

A context menu is available for each cursor, which offers you access to other functions. 
 

Cursor name 
Context menu 
item 

Meaning 

End of cable route Confirm as fault 
position 

Is used to confirm the cursor position as the cable fault position 

You can further select the phase on which the measurement was 
performed. 

Further information: Chapter Confirming cursor positions (on page 
59) 

Confirm as end of 
cable route 

Is used to confirm the cursor position as the end of the cable route 

Further information: Chapter Confirming cursor positions (on page 
59) 

Delete Deletes the cursor 

Properties... Opens the cursor properties (name and position of cursor) 

Cable fault Confirm as fault 
position 

Is used to confirm the cursor position as the cable fault position 

You can further select the phase on which the measurement was 
performed. 

Further information: Chapter Confirming cursor positions (on page 
59) 

Delete Deletes the cursor 

Properties... Opens the cursor properties (name and position of cursor) 

Start of cable 
route 

Delete Deletes the cursor 

Properties... Opens the cursor properties (name and position of cursor) 

Info cursor 

(added manually) 

Confirm as fault 
position 

Is used to confirm the cursor position as the cable fault position 

You can further select the phase on which the measurement was 
performed. 

Further information: Chapter Confirming cursor positions (on page 
59) 

Confirm as joint 
position 

Is used to confirm the cursor position as joint position 

Further information: Chapter Confirming cursor positions (on page 
59) 
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Cursor name 
Context menu 
item 

Meaning 

Confirm as end of 
cable route 

Is used to confirm the cursor position as the end of the cable route 

Further information: Chapter Confirming cursor positions (on page 
59) 

Select reference 
cursor 

Is used to select another Info cursor as reference cursor 

Further information: 

 Chapter Measuring the distance between two cursors (on page 
59) 

 Chapter Calculating the fault distance (on page 60) 

Save Saves the cursor at this position 

The saved cursor is still displayed after restarting the software.  

Delete Deletes the cursor 

Properties... Opens the cursor properties (name and position of cursor) 

 

Evaluation with context menus in reflection images 

If the reflection images are not clear, for example, because two traces are too close to each 
other, you can adjust the display of the trace. From the context menu in the reflection image, 
you can change the amplitude of a trace, use a trace as a reference curve and compare two 
traces with each other. 

Further information on evaluation with context menus: 

 Chapter Scaling the amplitude of a trace (on page 60) 

 Chapter Moving the trace (on page 61) 

 Chapter Defining the trace as the reference curve (on page 61) 

 Chapter Displaying the difference area between two traces (on page 61) 

 Chapter Displaying the difference curve of two traces (on page 62) 

 Chapter Displaying the mean curve of two traces (on page 62) 

 Chapter Adding a horizontal line in the reflection image (on page 63) 
 

Adding, moving and saving cursors 

1. Double-click in the reflection image. 

A cursor is added. 

2. Repeat step 1 until the desired number of cursors has been added. 

3. To move a cursor, click on the cursor flag and hold down the mouse button to drag the 
cursor to the desired position. 

4. To save a cursor at a certain position, right-click on the cursor flag and select the Save 
context menu item. 

Note: A cursor will only still be displayed in the software, even after restart, once you have 
added and saved it manually. 
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Confirming cursor positions 

Confirming the cursor position as the fault position 
 

 

 

Figure: Cable image with fault position and tolerance range 
 

1. In the reflection image, right-click on the cursor flag. 

2. In the context menu, select the Confirm as fault position menu item. 

3. In the extended context menu, select the phase where the fault occurred.  

The fault position is displayed in the reflection image and in the cable image. A tolerance 
range is displayed around the pre-located fault position and the fault can be located within 
this range. In the cable image, the faulty phase is also indicated with an error symbol. 

The cursor is no longer displayed. 

Note: This function is not available for the ICM method. With this method, the fault distance is 
calculated using a different procedure. Further information: Chapter Evaluating the ICM 
transient image (on page 107) 

Confirming the cursor position as the joint position 

This action can be performed only with Info cursor type cursors.  

1. In the reflection image, right-click on the cursor flag. 

2. In the context menu, select the Confirm as joint position menu item. 

The joint is displayed in the reflection image and in the cable image. 

The cursor is no longer displayed. 

Confirming the cursor position as the end of the cable route 

This action can be performed only with Info cursor or End of cable route type cursors. 

1. In the reflection image, right-click on the cursor flag. 

2. In the context menu, select the Confirm as end of cable route menu item. 

3. Select whether the cable length or the velocity of propagation should be adjusted in the 
previous section and click the OK button. 

The selected parameter is modified. 
 

Measuring the distance between two cursors 

This function is available only after a measurement with the TDR or SIM/MIM pre-location 
method. 

1. Double-click in the reflection image at the desired position. 

A cursor with the letter A is added. 

2. Double-click in the reflection image at a second position. 

A cursor with the letter B is added. 

3. To move a cursor, click on the cursor flag and hold down the mouse button to drag the 
cursor to the desired position. 
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4. Right-click on the cursor flag of one of the cursors and select the Select reference cursor 
context menu item. 

5. Select the letter of the other cursor. 

A blue bar with the distance is displayed (in meters or feet). 

6. To save this displayed distance, right-click on the blue bar and select the Save context 
menu item. 

Note: The displayed distance will only still be displayed, even after restarting the software, 
once you have saved it. 

 

Calculating the fault distance 

This function is available only after a measurement with the ICM method.  

1. You can insert a horizontal auxiliary guide line to precisely position the cursors used for 
calculating the fault distance. For this, right-click in the reflection image and select the Add 
horizontal line context menu item. 

2. To move the line, click on the line and hold down the mouse button to drag it to the desired 
position. 

3. Double-click in the reflection image at the beginning of a reflection period. 

A cursor with the letter A is added. 

4. Double-click in the reflection image at the end of a reflection period. 

A cursor with the letter B is added. 

5. To position a cursor precisely, click on the cursor flag and hold down the mouse button to 
drag the cursor to the desired position. 

6. Right-click on the cursor flag of one of the cursors and select the Select reference cursor 
context menu item. 

7. Select the letter of the other cursor. 

A blue bar with the fault distance is displayed (in meters or feet). The fault distance is 
produced from the time difference between two cursors minus the test lead length (in ns). 

8. To save this displayed fault distance, right-click on the blue bar and select the Save 
context menu item. 

Note: The displayed fault distance will only still be displayed, even after restarting the 
software, once you have saved it. 

Confirm as fault position 

 To confirm the fault distance as the fault position, right-click on the blue bar and select the 
Confirm as fault position context menu item. 

The fault position is displayed in the cable image. A tolerance range is displayed around 
the pre-located fault position and the fault can be located within this range. The faulty 
phase is also indicated by a fault symbol. 

 
 

Scaling the amplitude of a trace 

1. To select a trace, double-click on the trace in the list of completed measurements. 

The trace is shown in bold in the reflection image and in the list of completed 
measurements. 

2. In the reflection image, right-click on the selected trace and select the Scale the 
amplitude context menu item. 
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3. Set the amplitude. 

4. To save the settings, click the OK button. 

5. To reset the scaling to 100%, right-click on the trace and select the Reset the amplitude 
context menu item. 

 

Moving the trace 

1. To select a trace, double-click on the trace in the list of completed measurements. 

The trace is shown in bold in the reflection image and in the list of completed 
measurements. 

2. In the reflection image, click on the selected trace and hold down the mouse button to drag 
it to the desired position. 

3. To reset the trace to its original position, in the reflection image, right-click on the moved 
trace and select the Reset the curve position context menu item. 

 

Defining the trace as the reference curve 

1. To select a trace, double-click on the trace in the list of completed measurements. 

The trace is shown in bold in the reflection image and in the list of completed 
measurements. 

2. In the reflection image, right-click on the selected trace and select the Use as reference 
curve context menu item. 

In the reflection image, this trace is displayed as a dotted line. 

In the list of completed measurements, the word Reference is displayed with this trace. 

3. To stop using the trace as a reference curve, right-click in the reflection image and select 
the Clear the reference curve context menu item. 

 

Displaying the difference area between two traces 

You can highlight the differences between two traces more distinctly by displaying the area 
between these traces. 
 

 

 

1. To select a trace, double-click on the trace in the list of completed measurements. 

The trace is shown in bold in the reflection image and in the list of completed 
measurements. 

2. To select the second trace, double-click on the second trace in the list of completed 
measurements. 

Both traces are shown in bold in the reflection image and in the list of completed 
measurements. 
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3. In the reflection image, right-click on one of the selected traces and select the Display the 
difference area context menu item. 

The area between the two selected traces is shown in a bright colour. 

4. To hide the difference area, right-click in the reflection image and select the Hide the 
difference area context menu item. 

 

Displaying the difference curve of two traces 

You can highlight the differences between two traces more distinctly by displaying a difference 
curve. To calculate the difference curve, the difference between each point of the two selected 
traces is calculated. The resulting values are displayed as a white curve. 
 

 

 

1. To select a trace, double-click on the trace in the list of completed measurements. 

The trace is shown in bold in the reflection image and in the list of completed 
measurements. 

2. To select the second trace, double-click on the second trace in the list of completed 
measurements. 

Both traces are shown in bold in the reflection image and in the list of completed 
measurements. 

3. In the reflection image, right-click on one of the selected traces and select the Display the 
difference curve context menu item. 

The difference curve is displayed as an additional white curve. 

4. To hide the difference curve, right-click in the reflection image and select the Hide the 
difference curve context menu item. 

 

Displaying the mean curve of two traces 

If the curve course is uneven, you can display a mean curve. To calculate the mean curve, the 
points of the two selected traces are added and divided by 2. The resulting values are 
displayed as a white curve. 
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1. To select a trace, double-click on the trace in the list of completed measurements. 

The trace is shown in bold in the reflection image and in the list of completed 
measurements. 

2. To select the second trace, double-click on the second trace in the list of completed 
measurements. 

Both traces are shown in bold in the reflection image and in the list of completed 
measurements. 

3. In the reflection image, right-click on one of the selected traces and select the Display the 
mean curve context menu item. 

The mean curve is displayed as an additional white curve. 

4. To hide the mean curve, right-click in the reflection image and select the Hide the mean 
curve context menu item. 

 

Adding a horizontal line in the reflection image 

This function is available only after a measurement with the ICM pre-location method. The 
horizontal line is a tool for positioning the cursor more precisely so as to calculate the fault 
distance. 

1. Right-click in the reflection image and select the Add horizontal line context menu item. 

2. To move the line, click on the line and hold down the mouse button to drag it to the desired 
position. 

3. To delete the horizontal line, right-click on the line and select the Delete context menu 
item. 

 

9.3 System messages 

The system generates information and error messages to help you while performing 
measurements. 
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Notifications bar 
 

 
 

The information and error messages are displayed at the top right of the screen - in the 
notifications bar. When you rest the mouse pointer over a system message, a tooltip displays 
detailed information on the fault or the current status. 

The error message is displayed until the fault is rectified.  

In the information messages, on the right, you will see a cross that you can use to hide the 
information messages. 

Measurement dialog 

Information on the current measurement as well as faults that occur during the measurement 
are displayed in the bottom area of the Start/stop measurement dialog. Information is shown 
in blue font, faults in red. 

Further information on the meaning of error messages and corrective measures: Chapter 
Errors and corrective measures (on page 129) 

 

9.4 Software configuration 

9.4.1 Selecting the language 

Tools > Settings > Language and units 

1. In the Tools menu, select the Settings menu item. 

2. In the Settings dialog, select the Language and units tab. 

3. In the Language list, select the desired language. 

List of available languages: Chapter Technical data (on page 37) 

4. To save the settings, click the OK button. 

5. To display the BAUR system software in the selected language, restart the software. 

The user interface is displayed in the selected language. Reports already created are also 
displayed in the selected language. 

 

9.4.2 Selecting the system of units 

Tools > Settings > Language and units 

1. In the Tools menu, select the Settings menu item. 

2. In the Settings dialog, select the Language and units tab. 

3. To display units in the metric system (meters and degrees Celsius), in the System of 
units list, select Metric units (SI). 

To display units in the Anglo-American system (feet and degree Fahrenheit), in the 
System of units list, select GB/US units. 

4. To save the settings, click the OK button. 
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The units are displayed in the selected system of units. 
 

9.4.3 Activating the simulation mode 

Tools > Simulation mode 

1. In the Tools menu, select the Simulation mode menu item. 

2. Restart the software to be able to work in the simulation mode. 

If the simulation mode is enabled, the text Simulation mode is displayed in the upper 
menu bar. 

 

9.4.4 Setting up quick access buttons on the Dashboard 

1. In the Tools menu, select the Settings menu item. 

2. In the Settings dialog, select the Dashboard tab. 

3. In the Select buttons list, enable up to three functions. 

4. To save the settings, click the OK button. 

The enabled functions are displayed as buttons in the QUICK ACCESS area in the 
Dashboard. 

 

9.4.5 Activating options 

1. In the Tools menu, select the Settings menu item. 

2. In the Settings dialog, select the Options tab. 

The available and activated options, including corresponding option code, are displayed. 

3. You require an option code to activate an option. For this, take note of the displayed 
hardware identifier and contact your BAUR representative 
(http://www.baur.eu/baur-worldwide). 

You will receive an option code for each option that is to be activated. 

4. Enter the option code in the input field and click on the Activate button. 

The option is displayed as activated. 

5. To save the settings, click the OK button. 

6. Restart the software to be able to use the options in the BAUR system software. 
 

9.4.6 Entering cable routes 

1. In the Dashboard, in the QUICK ACCESS area, click the Enter new cable route button. 

Alternately, in the File menu, select the Enter new cable route menu item or right-click in 
the BAUR GeoBase Map and select the Enter new cable route context menu item. 

The Cable data dialog opens. 

2. Select the General information tab. 

You can now enter the following properties, amongst others, for the cable route: 

 Cable route name 

 Length of the cable route 

 Velocity of propagation (v/2) 

 Number of phases 

 Name of the substation at the start of the cable route 

 Name of the substation at the end of the cable route 

 Nominal voltage (Uo/U)   
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Note: The Nominal voltage (Uo/U) selection list contains the nominal voltages that were 
entered under Tools > Voltage assistant and were activated for display in the selection 
list.  

Further information: Chapter Entering the nominal voltage (on page 66) 

3. To map the cable route on the map, select the Map tab. 

Further information: Chapter Mapping the cable route on the map (on page 67) 

4. To add the joint positions on the cable route, select the Joints tab. 

Further information: Chapter Entering joints (on page 68) 

5. To add images, select the Images tab. 

Further information: Chapter Adding images (on page 69) 

6. To save the settings, click the OK button. 

The new cable route is created with the entered cable data and is displayed in the CABLE 
ROUTES area. 

Adding measurement data to a new or existing cable route after the measurement 

1. In the dashboard, select the CABLE FAULT LOCATION tab without selecting the cable 
route.  

The Cable route information bar displays No name as the name of the cable route as well 
as the standard data stored for cable length, velocity of propagation, nominal voltage and 
number of phases. 

2. To modify the standard data, in the Cable route information bar, enter the desired data. 

3. Perform the analyses and measurements. 

After completing the cable fault location on the cable route - on closing the software or 
switching to the Dashboard and selecting a cable route - the Save measurement data 
dialog opens.  

4. Select if you want to enter a new cable route for the measurement data, if you want to add 
the measurement data to an existing cable route or if you want to discard the 
measurement data. 

Alternately, you can enter a new cable route for the measurement data any time by clicking 
the Cable data button in the cable image. 

 

9.4.7 Entering the nominal voltage 

 In the cable image or in the Cable data dialog, enter the nominal voltage in the Nominal 
voltage (Uo/U) selection list. 

Recommendation: Now set the parameter values for the insulation resistance 
measurement and the voltage specifications for this new nominal voltage for each 
measurement method. To do this, you require Administrator rights. 

Further information: 

 Chapter Setting the parameters for insulation resistance measurement (on page 73) 

 Chapter Setting the voltage specifications per method (voltage assistant) (on page 75) 
 

Entering the nominal voltage in the Voltage assistant dialog 

Prerequisite 

You have Administrator rights for the BAUR system software. 

Procedure 

1. In the Tools menu, select the Voltage assistant menu item. 

2. In the New nominal voltage (Uo/U) input field, enter the name of the desired nominal 
voltage. 
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3. Click the Add nominal voltage button. 

The nominal voltage is added with standard data and is displayed in the Default nominal 
voltage selection list. In addition, the nominal voltage is displayed in the Nominal voltage 
(Uo/U) selection lists of the cable image and the Cable data dialog. 

4. To set the parameters for the insulation resistance measurement, select the Insulation 
measurement tab and enter the new parameters. 

5. To set the voltage specifications per measurement method, select the Pre-location tab 
and enter the voltage specifications per method. 

6. To change the name of the nominal voltage, in the Nominal voltage (Uo/U) input field, 
enter the desired name. 

7. To hide the nominal voltage, disable the Display nominal voltage checkbox. 

Note: If you hide a nominal voltage, it is no longer displayed in the Nominal voltage 
(Uo/U) selection list of the cable image and the Cable data dialog. However, the nominal 
voltage is still displayed in the Voltage assistant selection list in the Default nominal 
voltage dialog. 

8. To save the settings, click the OK button. 
 

9.4.8 Deleting cable routes 

1. In the File menu, select the Select cable route menu item. 

2. In the Select cable route dialog, select the cable route that you want to delete. 

3. Click the Delete cable route button. 

Alternately, click on the  icon of the cable route. 

4. To confirm the message, click the Yes button. 

The cable route is deleted. 
 

9.4.9 Mapping the cable route on the map 

Prerequisites 

 The BAUR GeoBase Map is available. 

 The cable route is known. 

Procedure 

1. In the CABLE ROUTES area, click on the  icon of the cable route that you want to edit. 

2. In the Cable data dialog, select the Map tab. 

The  icon is marked on the map and stands for the substation at the start of the cable 
route.  

3. To specify a substation at the end of the cable route, click the Add station button. 

A second  icon is marked on the map and stands for the substation at the end of the 
cable route. 

The cable route is displayed as a dashed line. 

4. To move a substation, click on the  icon and hold down the mouse button to drag it to 
the desired location. 

5. Click on the cable route to insert a route point to move the route. 

The cable route becomes a continuous line, a route point is displayed.  

6. To change the route of the cable, click on the route point and hold down the mouse button 
to move it to the desired location. 

7. Repeat steps 5 and 6 until the marked cable route matches the real cable route. 
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The software automatically calculates the marked length of the cable route. If the marked 
length exceeds the specified length, the cable route turns red. 

8. To save the settings, click the OK button. 
 

9.4.10 Entering joints 

Entering joints in the Cable data dialog 

1. In the Dashboard, in the CABLE ROUTES area, click on the  icon of the cable route for 
which you want to enter joints. 

Alternately, in the CABLE FAULT LOCATION tab, click the Cable data button. 

2. Select the Joints tab. 

You can now enter the following joint properties: 

 Identification number 

 Position 

 Year of installation 

 Installation temperature 

 Construction type 

 Manufacturer 

3. To save the joint, click the Save/update joint button. 

The joint is displayed in the Available joints list. 

4. To enter more joints, click the Enter new joint button. 

Entering joints via the joint search 

This joint search is possible only after a measurement with the TDR or SIM/MIM pre-location 
method. 

1. After performing a measurement with a suitable pre-location method, in the list of 
completed measurements, enable the checkbox of a single trace. 

2. In the reflection image, click the Search for joints button. 

Possible joint positions are displayed in the reflection image and in the cable image with 
dotted lines. 

3. To decrease or increase the sensitivity of the joint search, move the slider to the left or 
right. 

4. To confirm a joint, in the cable image, right-click on the dotted joint and select the Confirm 
joint context menu item. 

The joint is added to the cable route and is displayed in the cable image. 

5. To move the joint, click on the joint and hold down the mouse button to drag it to the 
desired position. 

Entering joints directly in the cable image 

1. In the CABLE FAULT LOCATION tab, in the cable image, right-click at the point where 
you want to add the joint and select the Add joint context menu item. 

A joint is displayed in the cable image. 
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2. To move the joint, click on the joint and hold down the mouse button to drag it to the 
desired position. 

Entering joint properties 

1. To enter the joint properties, right-click on the joint in the cable image and select the 
Properties... context menu item. 

You can now enter the following joint properties: 

 Identification number 

 Position 

 Year of installation 

 Installation temperature 

 Construction type 

 Manufacturer 

 Name of person who installed the joint 

 Comments 

2. To save the settings, click the OK button. 

Note: You can enter the most important joint properties in the Cable data > Joints dialog.  
 

9.4.11 Deleting joints 

1. In the Dashboard, in the CABLE ROUTES area, select the cable route from where you 
want to delete the joint. 

2. Select the CABLE FAULT LOCATION tab. 

3. In the cable image, right-click on the joint that you want to delete. 

 

4. Select the Delete context menu item. 

The joint is deleted without any confirmation message. 
 

9.4.12 Adding images 

1. In the Dashboard, in the CABLE ROUTES area, click on the  icon of the cable route for 
which you want to enter an image. 

2. In the Cable data dialog, select the Images tab. 

3. Click the Add image button. 

4. In the Add image dialog, select the Browse button. 

5. Select the folder where the image is saved and click on the image. 

6. Click the OK button. 

7. To change the name of the image, in the Name input field, enter another name. 

8. To insert a description for the image, enter text in the Image description input field. 

9. Click the Add button. 

10. Repeat steps 4 to 9 for each additional image you want to add. 

11. To save the settings, click the OK button. 
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9.4.13 Editing properties of a cable section 

A cable section is a section of the cable route between two joints or between a joint and the 
termination.  
 

 

 

Figure: Cable image with a joint and two cable sections 
 

1. In the Dashboard, in the CABLE ROUTES area, select the cable route where you want to 
edit the cable sections. 

2. Select the CABLE FAULT LOCATION tab. 

3. Right-click in the cable image (in the area of the desired cable section) and select the 
Properties... context menu item. 

You can now enter the following properties for the cable section: 

 Identification number 

 Velocity of propagation (v/2) 

 Year of installation 

 Manufacturer 

 Insulation 

 Comments 

4. To save the settings, click the OK button. 
 

9.4.14 Velocities of propagation (v/2) 
 

Cable type Insulation Velocity of propagation (v/2) 

Power cable, nominal voltage: 1 kV 

NKBA Soaked paper insulation 73 - 88 m/µs 

NYY PVC 74 - 90 m/µs 

NAKLEY Soaked paper insulation 81 - 88 m/µs 

NYCY PVC 75 - 79 m/µs 

NAKLEY Soaked paper insulation 81 - 88 m/µs 

NA2XY XLPE Approx. 80 m/µs 

HV cable, nominal voltages: 10 kV, 20 kV, 30 kV, 110 kV 

N(A)KBA Soaked paper insulation 79 - 84 m/µs 

NA2XS(F)2Y XLPE 81 m/µs 
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Cable type Insulation Velocity of propagation (v/2) 

NA2YSY PE 76 m/µs 

NHEKBA Soaked paper insulation 73 - 80 m/µs 

NKY Soaked paper insulation 58.5 m/µs 

A2YHS(2)Y PE 83 - 87 m/µs 

StYHS2Y PE 69.6 m/µs 

Telecommunication cable 

Switchboard cable PVC 85 m/µs 

HF cable Paper 0.4 mm core diameter 105 m/µs 

KX switchboard cable Full PE 0.5/3.0 96 m/µs 

KX-RGU 220 Full PE 50 Ohm 99 m/µs 

KX-179 BU Teflon 75 Ohm 99 m/µs 

KX-HF cable Full PE 2.3/10 60 Ohm 100 m/µs 

KX 2.6/9.5 Styroflex 75 Ohm 144 m/µs 

 

Note: The specifications are based on empirical values and vary depending on the cable 
manufacturer. The exact specifications of the cable manufacturer for a cable are given in the 
relevant data sheet. 

 

9.5 Data exchange 

The BAUR system software offers the following options for exchanging data: 

 Export/import of the cable database 

All cable routes including corresponding measurement data will be exchanged. This 
makes it possible, e.g., to make the data available for analysis to a measurement engineer 
in the office or to exchange data between different systems. 

 Export/import of GIS data 

The cable data as well as the cable routes are exchanged as vector data in a defined 
format (GEOJSON). This makes it possible, e.g. to import cable routes into the BAUR 
system software that were already established in a geographical information system (GIS). 

The data exchange format must be complied with for the data exchange to work. 

 To obtain information on the format of the exchange file, please contact your BAUR 
representative (http://www.baur.eu/baur-worldwide). 

 Importing cable data from the BAUR system software 3 

The cable data of the BAUR system software 3 is transferred into the BAUR system 
software 4 as cable routes. 

 Data backup 

Optionally, the cable database and all system settings and/or the system protocols may be 
exported. 
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9.5.1 Exporting cable database 

1. In the Tools menu, select the Data exchange menu item and then Export cable 
database. 

2. Select the folder in which you want to save the file. 

3. To save the file under a different name, enter a name in the File name input field. 

Note: The file name must not contain the following characters: \ / : * ? "< > | 

4. Click the Save button. 

All cable routes including pertinent measurement data are saved in the selected folder as a 
ZIP file. 

 

9.5.2 Importing cable database 

1. In the Tools menu, select the Data exchange menu item and then Import cable 
database. 

2. Select the folder where the cable routes including the pertinent measurement data are 
saved as ZIP file. 

3. Select the required file. 

4. Click the OK button. 

All cable routes including pertinent measurement data will be imported. 
 

9.5.3 Exporting GIS data 

1. In the Tools menu, select the Data exchange menu item and then Export GIS data. 

2. Select the folder in which you want to save the file. 

3. To save the file under a different name, enter a name in the File name input field. 

Note: The file name must not contain the following characters: \ / : * ? "< > | 

4. Click the Save button. 

The cable data as well as the cable route are saved to the selected directory in a 
GEOJSON format. 

 

9.5.4 Importing GIS data 

Prerequisite 

The GIS data are available as vector data in a GEOJSON format. 

 To obtain information on the format of the exchange file, please contact your BAUR 
representative (http://www.baur.eu/baur-worldwide). 

Procedure 

1. In the Tools menu, select the Data exchange menu item and then Import GIS data. 

2. Select the folder in which the GIS data are saved. 

3. Select the required file. 

4. Click the OK button. 

The data are imported. 
 

9.5.5 Importing cable data from BAUR system software 3 

Prerequisite 

 The cable data is available in the C:\BaurMeasure folder or in the DAT file format. 



 

 

Syscompact 4000 Operating and configuring the BAUR system software 

822-180-2 73 / 150 

Procedure 

Tools > Data exchange > Import cable data from system software 3 

 In the Tools menu, select the Data exchange menu item and then Import cable data 
from system software 3. 

Importing cable data directly from the C:\BaurMeasure folder 

 Select the From local folder option and click on the Start import button. 

Importing cable data from a DAT file 

a. Select the From export file option and click on the Start import button.  

b. Select the folder in which the DAT file is stored. 

c. Select the required file. 

d. Click the OK button. 

The cable data are imported. 
 

9.5.6 Backing up data 

Tools > Data exchange > Data backup inc. system protocols 

1. In the Tools menu, select the Data exchange menu item and then Data backup inc. 
system protocols. 

2. Select the data that you want to export. 

3. Click the Backup button. 

4. Select the folder in which you want to save the file. 

5. To save the file under a different name, enter a name in the File name input field. 

Note: The file name must not contain the following characters: \ / : * ? "< > | 

6. Click the Save button. 

The selected data is saved to the selected folder as a ZIP file. 
 

9.6 Basic settings for fault location methods 

9.6.1 Setting the parameters for insulation resistance measurement 

Prerequisite 

You have Administrator rights for the BAUR system software. 

Procedure 

Tools > Voltage assistant. 
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1. In the Voltage assistant dialog, click on the nominal voltage for which you want to set the 
parameters for the insulation resistance measurement. 

2. Click the Insulation measurement tab.  

3. Enter the parameters. 

4. Click the OK button. 

The parameters are applied. 

Overview of available parameters 
   

Parameters Function 

Short-circuit up to Is used to enter the threshold value up to which the cable fault is displayed as a 
short-circuit 

Low-resistive faults up 
to 

Is used to enter the threshold value up to which the cable fault is displayed as a 
low-resistive fault 

High-resistive 
breakdown faults from 

Is used to enter the threshold value from which the cable fault is displayed as a 
breakdown fault 

High-resistive faults up 
to 

Is used to enter the threshold value up to which the cable fault is displayed as a 
high-resistive fault 

Recommended max. 
voltage 

Is used to enter the voltage that is proposed in the Measurement dialog of the 
insulation resistance measurement 

Max. voltage Is used to enter the maximum permissible voltage for the insulation resistance 
measurement 
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9.6.2 Setting the voltage specifications per method (voltage assistant) 

In the BAUR system software, you can set the maximum permissible voltage, recommended 
voltage and other voltage parameters for each method and nominal voltage. These voltage 
parameters are proposed when selecting the method for the cable route of the nominal voltage 
in question. 

Prerequisite 

You have Administrator rights for the BAUR system software. 

Procedure 

Tools > Voltage assistant 
   

 
   

1. In the Voltage assistant dialog, click on the nominal voltage for which you want to modify 
the voltage specifications. 

2. Click the Pre-location tab. 

3. Enter the voltage specifications per method.  

4. Click the OK button. 

The modified values are applied. 

Overview of available settings 
 

Setting Function 

Recommended 
voltage 

Is used to enter the voltage at which the fault location with the relevant measurement 
method is to be started 

The recommended voltage is displayed in the Measurement dialog before the 
measurement starts. 
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Setting Function 

Max. voltage Is used to enter the maximum permissible voltage for cables of the selected nominal voltage 

During the measurement, the voltage should be increased only up to this maximum 
permissible voltage. The max. voltage is displayed in the Measurement dialog before the 

measurement starts. 

   

The availability of other parameters depends upon the system configuration. 
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10.1 Insulation resistance measurement 

10.1.1 About insulation resistance measurement 

By measuring the insulation resistance phase-to-earth potential and phase-to-phase, you can 
ascertain the position of the fault (between two phases or between phase and earth potential) 
and the type of fault. Different methods are suitable for the cable fault location depending on 
the type of fault.  

Following fault types are distinguished depending on the insulation resistance:  

 Short-circuits 

 Low-resistive cable faults 

 High-resistive cable faults  

With high-resistive faults a further distinction is made between: 

 Resistance faults: Cable faults that do not ignite on applying higher voltages, but which 
conduct and can change their resistance 

 Breakdown faults: Very high-resistive cable faults that ignite repeatedly from a specific 
voltage onwards 

 

10.1.2 Setting the measurement parameters 

1. In the dashboard, select the CABLE FAULT LOCATION tab and then the Fault analysis 
tab. 

2. To open the Settings dialog, click on the  icon. 

3. Set the measurement parameters for the insulation resistance measurement.  

The defined parameters are automatically applied. 

The following table provides an overview of the parameters that you can define. 

    

Measurement 
parameter 

Setting Function 

Measuring device IRG Is used for measurements with the IRG time domain reflectometer 
that is integrated into the system 

External device Is used for measurements with an external device 

The external device is not controlled via the BAUR system software. 
If you perform the measurement with an external device you can 
still manually enter the values determined in this way. Further 
information: Chapter Entering resistance values manually (on page 
79) 

Port TDR HV Is used for measurements with the HV connection cable 

TDR LV Is used for measurements with the TDR connection cable 
(depending upon system configuration) 

10 CABLE FAULT ANALYSIS  
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Measurement 
parameter 

Setting Function 

Measuring 
technique 

Earth-referenced Is used for measurements with connection to the earth potential  

The electric field is measured against earth (earth-referenced). This 
measuring technique is recommended for cable faults due to earth 
contact. 

Floating Is used for measurements without connection to the earth potential  

This measuring technique enables measurements free from earth 
effects. 

   
 

10.1.3 Performing an insulation resistance measurement 

Prerequisites 

 The test area is secured. 

 The test object is connected properly. 

Further information: Chapter Connecting the test object (on page 43) 

 The system is ready for operation. 

Further information: Chapter Commissioning (on page 52) 
 

Procedure 
 

1. BAUR system software 4 

 

Select CABLE FAULT LOCATION > Fault analysis. 

The Insulation measurement method is automatically selected. 

2. 

 

In the phase selector, select the combination(s) with which you are 
going to perform the measurement (phase - earth potential, phase 
- phase). 

3. 

 

If you want to change the measurement parameters, click on the 

 symbol. 

 

4. 

 

Click the Start measurement button. 



 

 

Syscompact 4000 Cable fault analysis 

822-180-2 79 / 150 

5. 

 

In the Measurement dialog, enter the maximum voltage at which 
the insulation resistance measurement should be performed, then 
click on the Start measurement button. 

Further information on the parameters of the insulation resistance 
measurement: Chapter Setting the voltage specifications per 
method (voltage assistant) (on page 75) 

The measurement is performed. Once the measurement is 
complete, the measured resistance values are displayed in the 
analysis diagram. 

End measurement or connect other phase 

6. 

 

To protect the system against restarting, press the emergency off 
button and remove the safety key. 

 
DANGER  

Dangerous voltage on the test object and other live plant parts. Danger to life, risk of injury from high 

electric voltage. 

7.  Before touching the test object, discharge, earth and short it: at the 
connection point and at the far end. 

You may touch the plant parts that were under voltage only if they 
are visibly earthed and short-circuited. 

  

Next steps 

 Evaluating resistance values: Chapter Evaluating resistance values (on page 79) 

 Comparing current measurement results with earlier results: Chapter Comparing 
resistance values with the previous values (on page 80) 

 Inserting measurement results into the report: Chapter Inserting measurement results in 
the report (on page 80) 

 

10.1.4 Entering resistance values manually 

1. In the Insulation measurement view, click the Enter values button.  

Alternately, in the bottom area of the analysis diagram, you can click on any phase 
combination (blue), e. g. L1-N. 

The Enter resistance values dialog opens. 

2. Enter the resistance values and select the unit, e.g. MOhm.  

3. To save the resistance values you entered, click the Save button. 

The entered values are displayed in the analysis diagram and faults are assigned to fault 
types.  

Further information: Chapter Setting the parameters for insulation resistance 
measurement (on page 73) 

 

10.1.5 Evaluating resistance values 

The fault analysis is performed automatically in the BAUR system software after measurement 
of the insulation resistance or after manual input of the resistance values. The results of the 
analysis are displayed in the analysis diagram. 
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The threshold values for the various fault types are taken from the voltage assistant (under 
Tools > Voltage assistant). You require Administrator rights to change these threshold 
values. Further information: Chapter Setting the parameters for insulation resistance 
measurement (on page 73) 

 

10.1.6 Comparing resistance values with the previous values 

1. To compare the current resistance values with the resistance values from previous 
measurements, in the Insulation measurement view, click the Previous values button.  

2. In the Previous values dialog, check the desired measurement and click the OK button. 

The previous measurement results are displayed as a grey bar next to the current values 
in the analysis diagram.  

3. To hide the previous resistance values, right-click in the analysis diagram and select the 
Hide previous values context menu item. 

 

10.1.7 Inserting measurement results in the report 

1. To insert the resistance values in the report, click the Insert graph in report button. 

2. Enter a name for the graph and click the OK button.  

The resistance values are exported to the report in table format.  
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10.2 Determining the breakdown voltage 

10.2.1 About determining the breakdown voltage 

To select a suitable fault location procedure, it is necessary to check whether the cable can be 
charged and to determine the breakdown voltage. For this, a DC voltage is applied to each 
phase for a brief period.  

The determined breakdown voltage is used to set the optimum voltage for the fault location. 
 

10.2.2 Performing measurements for breakdown voltage determination 

Safety instructions for determining the breakdown voltage 
   

 
 WARNING 

Arcing faults and noise that can damage hearing as a result of 
cable breakdown 

Danger to life as a result of electric shock, burns, electro-ophthalmia, 
hearing damage.  

 Use suitable personal protective equipment against electric shocks 
and arcing faults. 

 Use ear protection.  

 Keep a safe distance from the connection point of the test object 
according to the nominal voltage of the network. 

   
   

NOTICE 

Erosion on short-circuit contacts inside the device caused by switching the 
operating mode under voltage 

 Only switch the SSG surge voltage generator to DC voltage operation when it is in 

a de-energised state (Position: ). 

   
 

Prerequisites 

 The test area is secured. 

 The test object is connected properly. 

Further information: Chapter Connecting the test object (on page 43) 

 The system is ready for operation. 

Further information: Chapter Commissioning (on page 52) 

 The drawbars on the SA 32 SIM/MIM coupling unit are pushed in (position: SSG). 
 

Procedure 
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1. SA 32 SIM/MIM coupling unit 

 

Set the sensitivity selector switch of the current indicator to the 
desired position. 

Recommendation: x100 position (highest setting) 

2. 

 

Pull out the test|SSG drawbar until it reaches the stop (position: 
test). 

3. SSG surge voltage generator 

 

Using the selector switch (left), choose a voltage range. 

4. Rotate the  rotary switch all the way to the left. 

5. 

 

Release the high voltage: To do this, press the  key. 

The system status changes to the Ready to switch on operating 
state. The red indicator light comes on. 

6. 

 

Set the imp/min selector switch to the  position (dc voltage). 

7. 

 

Switch on the high voltage: To do this, press the  key. 

The system status changes to the In operation operating state. The 

red indicator light and the  key light up. 

8. 

 

Using the  rotary switch, increase the output voltage. When 
doing this, take into account the maximum permissible voltage for 
the cable. 

9. SA 32 SIM/MIM coupling unit 

 

Observe the current indicator during the measurement. 

10. SSG surge voltage generator 

 

As soon as the current indicator deflects to the SA 32: read off the 
value displayed on the SSG voltage indicator. This is the 
breakdown voltage. 

11.  If no breakdown was achieved, increase the voltage (if permitted) 
and repeat the measurement. 

End measurement or connect other phase 
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12. SSG surge voltage generator 

 

Rotate the  rotary switch all the way to the left. 

13. 

 

Press the  key. 

The system changes to the safe Ready for operation operating 
state. The green indicator light comes on. 

14. 

 

To protect the system against restarting, press the emergency off 
button and remove the safety key. 

15. SA 32 SIM/MIM coupling unit 

 

Press in the drawbar (position: SSG). 

 
DANGER  

Dangerous voltage on the test object and other live plant parts. Danger to life, risk of injury from high 

electric voltage. 

16.  Before touching the test object, discharge, earth and short it: at the 
connection point and at the far end. 

You may touch the plant parts that were under voltage only if they 
are visibly earthed and short-circuited. 
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11.1 About cable testing 

During the cable testing, a voltage is applied between phase and screen for a specific period to 
test the insulation. The test is considered successful if no breakdown occurs. 

The test duration and the voltage are defined by applicable standards based on the insulating 
material. 

Note: The DC voltage is not suitable for cable testing of mixed, XLPE and PE insulated cables. 
On one hand, substantial faults are not detected with this testing technology. On the other 
hand, high DC voltage test levels can damage the dielectric. 

 

11.2 About cable sheath testing 

The cable sheath testing is used to look for outer cable damage (sheath faults) and is 
recommended for new systems, after repairs and for periodic checks. 

While checking for mechanical faults, a DC voltage is applied between cable sheath and earth. 
According to DIN VDE 0276, PE sheaths are tested with DC voltage up to 5 kV and PVC 
sheaths with DC voltage up to 3 kV. If increased leakage current is measured during the test, 
the sheath could be damaged.  

 

11.3 Performing a cable or cable sheath test 

11.3.1 Safety instructions for performing a test 
   

 
 WARNING 

Risk of arcing faults and noise that can damage hearing as a result 
of cable breakdown during testing. 

Danger to life as a result of electric shock, burns, electro-ophthalmia, 
hearing damage.  

 Use suitable personal protective equipment against electric shocks 
and arcing faults. 

 Use ear protection.  

 Keep a safe distance from the connection point of the test object 
according to the nominal voltage of the network. 

   
   

NOTICE 

11 CABLE AND CABLE SHEATH TESTING 
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Erosion on short-circuit contacts inside the device caused by switching the 
operating mode under voltage 

 Only switch the SSG surge voltage generator to DC voltage operation when it is in 

a de-energised state (Position: ). 

   
 

11.3.2 Prerequisites 

 The test area is secured. 

 The test object is connected properly. 

Further information: Chapter Connecting the test object (on page 43) 

 The system is ready for operation. 

Further information: Chapter Commissioning (on page 52) 

 The drawbars on the SA 32 SIM/MIM coupling unit are pushed in (position: SSG). 
 

11.3.3 Procedure 

   

1. SA 32 SIM/MIM coupling unit 

 

Set the sensitivity selector switch of the current indicator to the 
desired position. 

Recommendation: x100 position (highest setting) 

2. 

 

Pull out the test|SSG drawbar until it reaches the stop (position: 
test). 

3. SSG surge voltage generator 

 

Using the selector switch (left), choose a voltage range. 

4. Rotate the  rotary switch all the way to the left. 

5. 

 

Release the high voltage: To do this, press the  key. 

The system status changes to the Ready to switch on operating 
state. The red indicator light comes on. 

6. 

 

Set the imp/min selector switch to the  position (dc voltage). 

7. 

 

Switch on the high voltage: To do this, press the  key. 

The system status changes to the In operation operating state. The 

red indicator light and the  key light up. 

The cable test starts. 
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8. 

 

Using the  rotary switch, increase the output voltage. When 
doing this, take into account the maximum permissible voltage for 
the cable. 

9. SA 32 SIM/MIM coupling unit 

 

SSG surge voltage generator 

 

Observe the current and voltage indicators during the 
measurement. 

Cable testing: The cable test is considered successful if the 

target voltage has been reached and no breakdown has occurred 
within the preset time. 

Cable sheath testing: The cable sheath test is considered 

successful if no breakdown takes place and the leakage current 
does not exceed the specified value. This defined value depends 
on the sheath material, cable length and number of joints.  

10.  If a breakdown occurs, end the cable test. 

Note: After a breakdown, the surge voltage generator 

automatically switches to burn mode. 

End test or connect other phase 

11. SSG surge voltage generator 

 

Rotate the  rotary switch all the way to the left. 

12. 

 

Press the  key. 

The system changes to the safe Ready for operation operating 

state. The green indicator light comes on. 

13. 

 

To protect the system against restarting, press the emergency off 
button and remove the safety key. 

14. SA 32 SIM/MIM coupling unit 

 

Press in the drawbar (position: SSG). 

 
DANGER  

Dangerous voltage on the test object and other live plant parts. Danger to life, risk of injury from high 

electric voltage. 

15.  Before touching the test object, discharge, earth and short it: at the 
connection point and at the far end. 

You may touch the plant parts that were under voltage only if they 
are visibly earthed and short-circuited. 
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Cable fault pre-location Syscompact 4000 

88 / 150 822-180-2 

12.1 Safety instructions for cable fault location 
   

 
 WARNING 

Potential differences between the system and the earth possible 

Danger to life or risk of injury due to electric shock. 

If a cable fault is located near to the system, there may be potential 
differences between the system and the earth in surge mode.  

 Place the system at a distance of several meters to the cable route 
or cable fault location.  

 If operating in ‘surge mode’, cordon off the system at distance of at 
least 1.5 m.  

During surge mode, people may only stand outside the cordoned off 
area. 

 Before starting surge mode, check the cable route for potential 
dangers. 

   
   

NOTICE 

Erosion on short-circuit contacts inside the device caused by switching the 
operating mode under voltage 

 Only switch the SSG surge voltage generator to DC voltage operation when it is in 

a de-energised state (Position: ). 

   
 

12.2 TDR: Time Domain Reflectometry 

12.2.1 About the TDR method 

Areas of application 

 To detect the cable length and to test the velocity of propagation  

 To check if all phases are equal in length and if there is a cable break  

 To detect joints and other impedance changes 

 To compare healthy and faulty phases 

12 CABLE FAULT PRE-LOCATION 
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Measurement principle 

A transmitting pulse is fed into the cable. When the transmitting pulse reaches a position with 
impedance change (cable ends, faults or joints), a part of the pulse energy is reflected to the 
time domain reflectometer. These reflections are recorded and presented in a graph.  

The amplitude of a reflection is determined by the extent of the impedance change, which is 
defined by the reflection factor r:  

 
 

r Reflection factor 

Z1 Cable impedance up to impedance change  

Z2 Impedance of a change in the cable route (e.g. fault or joint) 
 

If the impedance of a change Z2 is greater than the cable impedance Z1, the reflection factor is 
positive. In the reflection image, the open cable end is displayed by a positive reflection. 
 

 
 

If the impedance of a change Z2 is less than the cable impedance Z1, the reflection factor is 
negative. In the reflection image, a short-circuit or a low-resistive fault is displayed by a 
negative reflection: 
 

 
 

To determine the fault distance, the time gap between the transmitting pulse and the reflecting 
pulse is measured. The fault distance is calculated with the following formula. 

 
 

l Fault distance 

t Time gap between the transmitting pulse and the reflecting pulse 

v/2 Velocity of propagation 
 

This formula shows that it is necessary to specify a correct velocity of propagation for precise 
determination of the fault distance. If the velocity of propagation is not known, it can be 
calculated with the cable length. 

Note: Time Domain Reflectometry not is suitable for locating high-resistive cable faults, as 
they produce very minor or no impedance changes at the fault position. 

 

12.2.2 Setting the measurement parameters 

CABLE FAULT LOCATION > Pre-location 

1. In the method selection list, select the TDR method. 

2. To open the Settings dialog, click on the  icon. 
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3. In the Settings dialog, select the Measurement parameters tab. 

4. Set the measurement parameters. 

The defined parameters are automatically applied. The following table provides an 
overview of the parameters that you can define. 

    

Measurement 
parameter 

Setting Function 

Port TDR HV Is used for measurements with the HV connection cable 

TDR LV Is used for measurements with the TDR connection cable 
(depending upon system configuration) 

Measurement mode Automatic The measurement parameters are defined automatically by the 
software. The first measurement must always be performed in this 
mode; other measurement modes are not available.  

If a measurement was performed in the Automatic measurement 

mode, it is displayed with the  icon in the list of completed 
measurements. 

Individual The measurement parameters can be customised.  

Continuous The measurement parameters can be customised.  The 
measurement runs continuously. The measured values are 
recorded and overwritten permanently.  

Mean value 
calculation 

The measurement parameters can be customised.  The 
measurement runs continuously. The average of the measured 
values is calculated. 

Stop after change The measurement parameters can be customised. The 
measurement runs continuously. If a fault is detected, the 
measurement is automatically aborted. 

Envelope mode This mode is particularly suitable for locating intermittent faults. 
Faulty traces are recorded until the measurement is stopped 
manually. Each impedance change is automatically saved 
immediately; the recorded measurement data is displayed as an 
envelope curve. In this way, very minor changes also remain 
immediately and permanently visible. 

Impedance 8 – 2,000 ohm Is used to set the input impedance 

Pretrigger 0.02 – 100 µs Is used to set how many microseconds before the trigger the signal 
starts recording 

Input signal gain Dynamic range 
107 dB (-63 to +44 
dB) 

Is used to set the input signal amplification 

Pulse width 0.02 – 1,300 µs Is used to set the pulse width 

The pulse width is set automatically depending on the measuring 
range. Narrow pulses have high resolution, however, they have a 
lower range due to the higher damping. They are especially suitable 
for shorter cables. When using wide pulses, the range increases 
and the resolution decreases.  
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Measurement 
parameter 

Setting Function 

Pulse voltage 20 – 200 V Is used to set the pulse voltage 

High pulses lead to magnified reflections. Consequently, the 
reflection images are easier to evaluate. However, if the pulse 
voltage is set too high, it can lead to overload. Moreover, in the case 
of pulses that have been set too high, signals, e.g. from joints, can 
be increased so much that they become difficult to differentiate from 
a fault reflection.  

Voltage-proof input Yes/No Enables and disables the input protection of the installed time 
domain reflectometer 

If Yes is selected, the input protection is activated up to AC 400 V.  

   
 

12.2.3 Performing the TDR measurement 

Prerequisites 

 The test area is secured. 

 The test object is connected properly. 

Further information: Chapter Connecting the test object (on page 43) 

 The system is ready for operation. 

Further information: Chapter Commissioning (on page 52) 
 

Procedure 
   

1. BAUR system software 4 

 

Select CABLE FAULT LOCATION > Pre-location > TDR. 

2. 

 

In the phase selector, select the combination(s) with which you are 
going to perform the measurement (phase - earth potential, phase 
- phase). 

3. 

 

Click on the  symbol and select the appropriate port: 

 TDR HV, if you perform the measurement via the HV 
connection cable connected to the low voltage LV coaxial 
connection socket. 

 TDR LV, if you perform the measurement via the TDR 
connection cable. 

Further information: Chapter Setting the measurement parameters 
(on page 89) 
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4. 

 

Click the Start measurement button. 

5. 

 

In the Measurement dialog, select the Start measurement 
button. 

The measurement is performed. The traces are displayed. Cursors 
are set automatically at the measured cable end and at the cable 
fault if applicable. 

End measurement or connect other phase 

6. 

 

To protect the system against restarting, press the emergency off 
button and remove the safety key. 

 
DANGER  

Dangerous voltage on the test object and other live plant parts. Danger to life, risk of injury from high 

electric voltage. 

7.  Before touching the test object, discharge, earth and short it: at the 
connection point and at the far end. 

You may touch the plant parts that were under voltage only if they 
are visibly earthed and short-circuited. 

 

Next steps 

 Evaluating the reflection image: 

 Chapter Evaluating TDR reflection images (on page 92) 

 Chapter Evaluating reflection images (on page 56) 

 Adjusting the cable length and velocity of propagation: Chapter Adjusting the cable length 
and velocity of propagation (on page 94) 

 Displaying possible joints: Chapter Searching for joints (on page 94) 

 Inserting the reflection image into the report: Chapter Inserting a reflection image into the 
report (on page 102)  

 

12.2.4 Evaluating TDR reflection images 

The reflections can be divided into two groups: 

 Normal reflections 

Even healthy phases can show reflections. These reflections are caused by 
inhomogeneities such as bends, connection points, meeting points of cable sections with 
different insulations or joints. 

 Reflections caused by faults 

A faulty phase shows normal reflections as well as reflections caused by faults. Due to the 
damping losses in the cable, a fault that is far away reflects a smaller pulse than a fault that 
is close by. 

To differentiate normal reflections from reflections caused by faults, it is always 
recommended comparing the traces of a faulty and a healthy phase.  
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Typical traces: 
 

 

Open cable end 

The reflection is a positively increasing pulse. There is no pulse from the 
far end. 

If the positive reflection is displayed before the actual cable end, there 
could be a cable break or the cable length could be incorrect.  

 

Short-circuit or low-resistive fault 

The reflection is a negatively decreasing pulse. There is no pulse from the 
far end. 

 

Changes in cable type, joints (impedance changes) 

The amplitude of the reflecting pulse depends on the extent of the 
impedance change. The joints generate s-shaped reflections. 

 

Procedure during evaluation 
 

 

 
1 Fault position (negative reflection) 
2 Cable end (positive reflection) 

 

1. If possible, compare the traces of a healthy and a faulty phase.  

The differences in the traces clearly indicate possible fault positions.  

2. Double-click to set a cursor at the position where the two traces separate.  

If you are unable to compare traces of two phases, set the cursor at the position where the 
trace points downwards. 

3. If required, adjust the position of the fault cursor. To do so, click on the flag of the fault 
cursor and hold down the mouse button to move the cursor to the desired position. 

4. To confirm the fault position, right-click on the cursor flag and select the Confirm as fault 
position context menu item. 

5. In the extended context menu, select the phase where the fault occurred.  
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The fault position is displayed in the reflection image and in the cable image. A tolerance 
range is displayed around the pre-located fault position and the fault can be located within 
this range. 

The cursor is no longer displayed. 
 

12.2.5 Adjusting the cable length and velocity of propagation 

1. If the software detects a big positive reflection, it interprets this reflection as a cable end 
and automatically sets an appropriate cursor after the measurement. Check the cursor 
position.  

2. If required, adjust the position of the cursor. To do this, click on the cursor flag and hold 
down the mouse button to move the cursor to the desired position. 

3. You now have two options: 

 Confirming the cursor position as the end of the cable route 

a. Right-click on the cursor flag and select the Confirm as end of cable route context 
menu item. 

The Confirm as end of cable route dialog opens. 

b. Select whether the cable length or the velocity of propagation should be adjusted in 
the previous section and click the OK button. 

The selected parameter is modified. 

 Confirming the cursor position as the fault position 

If the positive reflection in the TDR reflection image clearly differs from the specified 
cable length, there could be a cable break.  

a. In this case, right-click on the cursor flag and select the Confirm as fault position 
context menu item. 

b. In the extended context menu, select the phase where the fault occurred.  

The fault position is displayed in the reflection image and in the cable image. A 
tolerance range is displayed around the pre-located fault position and the fault can be 
located within this range. 

The cursor is no longer displayed. 
 

12.2.6 Searching for joints 

1. In the list of completed measurements, enable the checkbox of a single trace. 

2. In the reflection image, click the Search for joints button. 

Possible joint positions are displayed in the reflection image and in the cable image with 
dotted lines. 

3. To decrease or increase the sensitivity of the joint search, move the slider to the left or 
right. 

4. To confirm a joint, in the cable image, right-click on the dotted joint and select the Confirm 
joint context menu item. 

The joint is added to the cable route and is displayed in the cable image. 

 

5. To move the joint, click on the joint and hold down the mouse button to drag it to the 
desired position. 

6. To enter the joint properties, right-click on the joint and select the Properties... context 
menu item. 
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You can now enter the following joint properties: 

 Identification number 

 Position 

 Year of installation 

 Installation temperature 

 Construction type 

 Manufacturer 

 Name of person who installed the joint 

 Comments 

7. To save the settings, click the OK button. 
 

12.2.7 Inserting a reflection image into the report 

1. If you want to insert the reflection image in the report, click the Insert graph in report 
button. 

 

2. Enter a name for the graph and click the OK button. 
 

12.3 SIM/MIM: Secondary-Multiple Impulse Method 

12.3.1 About the SIM/MIM method 

The secondary-multiple impulse method (SIM/MIM) is the most well-established and precise 
pre-location method and in most cases, performs fast fault pre-location. It is used for 
pre-locating high-resistive faults. 

The SIM/MIM method is based on the electric arc surge method. With this method, first a 
reflection image is recorded without a fault or with a high-resistive fault. As high-resistive faults 
result in very minor or no impedance changes at the fault position, no fault is visible on this 
reflection image. Therefore, it is also called “healthy trace”. Then, a HV surge pulse is fed into 
the defective cable (phase), which ignites an electric arc at the fault position and temporarily 
converts the fault into a low-resistive connection. Reflection measurements are taken at the 
precise moment of the ignition. To do this, multiple LV pulses are fed into the cable and are 
reflected negatively at the temporarily low-resistive fault location. The reflection image is 
displayed on screen without and with an electric arc. The fault position at the negative 
reflection is clearly visible by comparing the reflection images. The fault distance is calculated 
from the duration of the pulse and the velocity of propagation (v/2).  

The breakdown time can be delayed or the duration of the breakdown can be shorter due to 
the varying properties of the cable fault. The multiple automatic reflection measurements 
ensure that the correct time at which the fault becomes low-resistive will be recorded. 
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Main circuit diagram 
 

 

 

DC-SIM/MIM: secondary/multiple impulse method used in DC mode 

The secondary-multiple impulse method in DC mode (DC-SIM/MIM) is recommended for the 
pre-location of high-resistive breakdown faults.  

Unlike the usual SIM/MIM method, with the DC-SIM/MIM method, the cable is charged with 
DC voltage through the surge voltage generator (capacitor-supported) until a breakdown 
occurs at the fault position. In doing so, in a chargeable cable, the cable capacitance is used to 
charge the energy and to reach a more intensive breakdown. In this way, high-resistive faults 
with delayed ignition can be located reliably. Precisely at the time of the ignition, reflection 
measurements are completed. The reflection image is displayed on screen without and with 
an electric arc. The fault position on the negative reflection is clearly visible by comparing the 
reflection images. The fault distance is calculated from the duration of the pulse and the 
velocity of propagation (v/2).  

The evaluation of the reflection images is performed exactly as in the SIM/MIM method. 
 

12.3.2 Setting measurement parameters 

CABLE FAULT LOCATION > Pre-location 

1. In the method selection list, select the SIM/MIM method. 

2. To open the Settings dialog, click on the  icon. 

3. In the Settings dialog, select the Measurement parameters tab. 

4. Set the measurement parameters. 

The defined parameters are automatically applied. The following table provides an 
overview of the parameters that you can define. 

   

Measurement 
parameter 

Setting Function 

Port SIM 1 Is used by default for SIM/MIM measurements 

 SIM 2 Is used if other surge voltage generators are available. 

Measurement mode Automatic The measurement parameters are set automatically. Measurement 
sequence: A healthy trace is first created and the fault traces are 
then recorded.  

If a measurement was performed in the Automatic measurement 

mode, it is displayed with the  icon in the list of completed 
measurements. 
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Measurement 
parameter 

Setting Function 

Individual The measurement parameters can be customised.  

Continuous A reference trace is recorded and then faulty traces are recorded 
until the measurement is stopped manually. 

Mean value 
calculation 

A reference trace is recorded and then faulty traces are recorded 
until the measurement is stopped manually. The mean of 
measurement results is calculated continuously.  

Envelope mode The measurement parameters can be customised.  

This mode is particularly suitable for locating intermittent faults. A 
healthy trace is recorded and then faulty traces are recorded until 
the measurement is stopped manually. Each impedance change is 
automatically saved immediately; the recorded measurement data 
is displayed as an envelope curve. In this way, very minor changes 
also remain immediately and permanently visible. 

Impedance 8 – 2,000 ohm Is used to set the input impedance 

Pretrigger 0.02 – 100 µs Is used to set how many microseconds before the trigger the signal 
starts recording 

Trigger delay 100 – 650 µs Is used to set the time between the trigger and the start of the 
measurement following the trigger 

Input signal gain Dynamic range 
107 dB (-63 to +44 
dB) 

Is used to set the input signal amplification 

Pulse width 0.02 – 1,300 µs Is used to set the pulse width 

The pulse width is set automatically depending on the measuring 
range. Narrow pulses have high resolution, however, they have a 
lower range due to the higher damping. They are especially suitable 
for shorter cables. When using wide pulses, the range increases 
and the resolution decreases.  

Pulse voltage 20 – 160 V Is used to set the pulse voltage 

High pulses lead to magnified reflections. Consequently, the 
reflection images are easier to evaluate. However, if the pulse 
voltage is set too high, it can lead to overload. Moreover, in the case 
of pulses that have been set too high, signals, e.g. from joints, can 
be increased so much that they become difficult to differentiate from 
a fault reflection. 

Number of pulses 1 – 20 Is used to set the number of faulty traces that are recorded 

Pause between 
pulses 

100 – 650 µs Is used to set the time between two LV pulses 
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12.3.3 Performing the SIM/MIM measurement 

Prerequisites 

 The test area is secured. 

 The test object is connected properly. 

Further information: Chapter Connecting the test object (on page 43) 

 The system is ready for operation. 

Further information: Chapter Commissioning (on page 52) 

 The drawbars on the SA 32 SIM/MIM coupling unit are pushed in (position: SSG). 
 

Procedure 
   

1. SA 32 SIM/MIM coupling unit 

 

Pull out the SA 32|SSG drawbar until it reaches the stop 

(position: SA 32). 

The SIM indicator light comes on. The fan can be heard. 

2. SSG surge voltage generator 

 

Using the selector switch (left), choose a voltage range. 

3. Rotate the  rotary switch all the way to the left. 

4. 

 

Release the high voltage: To do this, press the  key. 

The system status changes to the Ready to switch on operating 
state. The red indicator light comes on. 

5. 

 

Set the imp/min selector switch to the  position (single surge). 

6. 

 

Switch on the high voltage: To do this, press the  key. 

The system status changes to the In operation operating state. The 

red indicator light and the  key light up. 

7. BAUR system software 4 

 

Select CABLE FAULT LOCATION > Pre-location > SIM/MIM. 

8. 

 

In the phase selector, click on the phase on which you are 
performing the measurement. 
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9. 

 

If you want to change the measurement parameters, click on the 

 symbol. 

Further information: Chapter Setting measurement parameters (on 
page 96) 

10. 

 

Click the Start measurement button. 

11. 

 

In the Measurement dialog, select the Start measurement 

button. 

The measurement is performed. The healthy trace is displayed. 
The Waiting for breakdown message is displayed. 

12. SSG surge voltage generator 

 

Set the surge voltage to 20-30% higher than the breakdown 

voltage using the  rotary switch. 

Further information: Chapter Performing measurements for 
breakdown voltage determination (on page 81) 

 

 

The capacitors in the surge voltage generator are charged up; you 
can read off the actual voltage on the voltage indicator. 

13. 

 

When the desired target voltage has been reached, turn the  
rotary switch for the output voltage all the way to the left. 

The capacitors are charged and ready to emit the voltage. 

14. 

 

Release a single surge: To do this, press the  key. 

The time domain reflectometer automatically performs further 
measurements. The traces are displayed in the BAUR system 
software. Cursors are set automatically at the measured cable end 
and at the cable fault if applicable. 

End measurement or connect other phase 

15. SSG surge voltage generator 

 

Press the  key. 

The system changes to the safe Ready for operation operating 
state. The green indicator light comes on. 

16. 

 

To protect the system against restarting, press the emergency off 
button and remove the safety key. 
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17. SA 32 SIM/MIM coupling unit 

 

Press in the drawbar (position: SSG). 

The SIM indicator light goes out. 

 
DANGER  

Dangerous voltage on the test object and other live plant parts. Danger to life, risk of injury from high 

electric voltage. 

18.  Before touching the test object, discharge, earth and short it: at the 
connection point and at the far end. 

You may touch the plant parts that were under voltage only if they 
are visibly earthed and short-circuited. 

   

For measurements with DC voltage (DC-SIM/MIM) 

For DC-SIM/MIM measurements, adjust the settings on the surge voltage generator as 
follows: 

 Set the imp/min selector switch to the  position (dc voltage). 

 Using the  rotary switch, increase the output voltage until the metallic noise of a 
breakdown can be heard. 

Next steps 

 Evaluating reflection images: 

 Chapter Evaluating SIM/MIM reflection images (on page 100) 

 Chapter Evaluating reflection images (on page 56) 

 Displaying possible joints: Chapter Searching for joints (on page 102) 

 Inserting the reflection image into the report: Chapter Inserting a reflection image into the 
report (on page 102)  

 

12.3.4 Evaluating SIM/MIM reflection images 

The healthy trace and the first trace of the ignited fault are displayed in the reflection image. 
The fault cursor is set automatically after the measurement.  
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1 Fault position (negative reflection) 
2 Cable end (positive reflection) 

 

1. Compare both traces. A negative reflection is visible at the fault position. The two traces 
split at this point.  

To display other traces, in the list of completed measurements, enable the checkbox of the 
respective trace.  

2. If required, adjust the position of the fault cursor. To do so, click on the flag of the fault 
cursor and hold down the mouse button to move the cursor to the desired position. 

3. To confirm the fault position, right-click on the cursor flag and select the Confirm as fault 
position context menu item. 

4. In the extended context menu, select the phase where the fault occurred.  

The fault position is displayed in the reflection image and in the cable image. A tolerance 
range is displayed around the pre-located fault position and the fault can be located within 
this range. 

The cursor is no longer displayed. 

Notes 

 If the fault position is not properly visible in the reflection image, repeat the measurement 
at increased voltage (if permitted).  

Further information: Chapter Performing the SIM/MIM measurement (on page 98) 

If the fault position is still not properly visible: 

 Measure the insulation resistance again. 

The faulty trace may have changed due to the applied high voltage. After about three 
measurements, it is recommended measuring the insulation resistance again. 

Further information: Chapter Performing an insulation resistance measurement (on page 
78) 

Further information on evaluating the reflection image and using the cursor: Chapter 
Evaluating reflection images (on page 56) 
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12.3.5 Searching for joints 

1. In the list of completed measurements, enable the checkbox of a single trace. 

2. In the reflection image, click the Search for joints button. 

Possible joint positions are displayed in the reflection image and in the cable image with 
dotted lines. 

3. To decrease or increase the sensitivity of the joint search, move the slider to the left or 
right. 

4. To confirm a joint, in the cable image, right-click on the dotted joint and select the Confirm 
joint context menu item. 

The joint is added to the cable route and is displayed in the cable image. 

 

5. To move the joint, click on the joint and hold down the mouse button to drag it to the 
desired position. 

6. To enter the joint properties, right-click on the joint and select the Properties... context 
menu item. 

You can now enter the following joint properties: 

 Identification number 

 Position 

 Year of installation 

 Installation temperature 

 Construction type 

 Manufacturer 

 Name of person who installed the joint 

 Comments 

7. To save the settings, click the OK button. 
 

12.3.6 Inserting a reflection image into the report 

1. If you want to insert the reflection image in the report, click the Insert graph in report 
button. 

 

2. Enter a name for the graph and click the OK button. 
 

12.4 ICM: Impulse current method 

12.4.1 About the ICM method 

The impulse current method (ICM) is suitable for pre-location of the following cable faults: 

 high-resistive faults 

 wet faults 
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 faults in long cables 

 faults that cannot be located with the Time Domain Reflectometry due to high pulse 
damping 

A breakdown is generated at the fault through a HV surge pulse. The breakdown produces a 
travelling wave that drifts between the connection point of the surge voltage generator and the 
fault with alternating polarity. The current ratio of this transient wave is evaluated and the time 
interval between the periodically recurring reflections is measured. The distance of the fault 
position from the connection point is calculated from the measured time and the velocity of 
propagation in the cable. 

Main circuit diagram 
 

 
 

 
HV surge pulse of the surge voltage generator that is fed into the test object and that 
generates a breakdown at the fault. 

This breakdown produces a transient wave that spreads to the test object.  

 
Transient wave that is reflected from the fault to the connection point of the surge voltage 
generator.  

As the continuous electric arc produced by the breakdown is low-resistive, the polarity of 
the transient wave is reversed each time.  
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Transient wave that is reflected from the connection point of the surge voltage generator.  

As the connection point is low-resistive, the polarity of the transient wave is reversed each 
time. 

1, 2, 3 ... Reflection period number  

r Reflection factor 
 

 

12.4.2 Setting measurement parameters 

CABLE FAULT LOCATION > Pre-location 

1. In the method selection list, select the ICM method. 

2. To open the Settings dialog, click on the  icon. 

3. In the Settings dialog, select the Measurement parameters tab. 

4. Set the measurement parameters for the ICM measurement. 

The defined parameters are automatically applied. 

The following table provides an overview of the parameters that you can define. 

 

Measurement 
parameter 

Setting Function 

Port SK 1D The ICM measurement is only performed via the SK 1D port 
(inductive coupling). There are no other settings.  

Measurement mode Automatic The measurement parameters are defined automatically by the 
software. The first measurement must always be performed in this 
mode; other measurement modes are not available.  

If a measurement was performed in the Automatic measurement 

mode, it is displayed with the  icon in the list of completed 
measurements. 

 Individual The measurement parameters can be customised.  

Pretrigger 0.02 – 100 µs Is used to set how many microseconds before the trigger the signal 
starts recording 

Input signal gain Dynamic range 
107 dB (-77 to +30 
dB) 

Is used to set the input signal amplification 

   
 

12.4.3 Performing ICM measurements 

Prerequisites 

 The test area is secured. 

 The test object is connected properly. 

Further information: Chapter Connecting the test object (on page 43) 

 The system is ready for operation. 

Further information: Chapter Commissioning (on page 52) 
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 The drawbars on the SA 32 SIM/MIM coupling unit are pushed in (position: SSG). 
 

Procedure 
   

1. SSG surge voltage generator 

 

Using the selector switch (left), choose a voltage range. 

2. Rotate the  rotary switch all the way to the left. 

3. 

 

Release the high voltage: To do this, press the  key. 

The system status changes to the Ready to switch on operating 
state. The red indicator light comes on. 

4. 

 

Using the imp/min selector switch, select the desired surge 

sequence: 

: slow surge sequence 

: rapid surge sequence 

Note: The number of surges emitted per minute for a slow or rapid 

surge sequence depends upon the surge voltage generator. 

Further information: Chapter SSG surge voltage generator (on 
page 24) 

5. 

 

Switch on the high voltage: To do this, press the  key. 

The system status changes to the In operation operating state. The 

red indicator light and the  key light up. 

6. BAUR system software 4 

 

Select CABLE FAULT LOCATION > Pre-location > ICM. 

7. 

 

In the phase selector, click on the phase on which you are 
performing the measurement. 

8. 

 

If you want to change the measurement parameters, click on the 

 symbol. 

Further information: Chapter Setting measurement parameters (on 
page 104) 

9. 

 

Click the Start measurement button. 
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10. SSG surge voltage generator 

 

Using the  rotary switch, increase the output voltage until the 
metallic noise of a breakdown can be heard. 

11. BAUR system software 4 

 

If necessary, change the display range in relation to the cable 
length in the Measurement dialog. 

To ensure that many reflection periods can be presented for a 
better evaluation, enter at least 300% to 500%. The display range 
will show the three-fold or five-fold cable length. 

12. Click the Start measurement button. 

The measurement is performed. The transient image is displayed. 

End measurement or connect other phase 

13. SSG surge voltage generator 

 

Rotate the  rotary switch all the way to the left. 

 

 

Press the  key. 

The system changes to the safe Ready for operation operating 
state. The green indicator light comes on. 

14. 

 

To protect the system against restarting, press the emergency off 
button and remove the safety key. 

 
DANGER  

Dangerous voltage on the test object and other live plant parts. Danger to life, risk of injury from high 

electric voltage.  

15.  Before touching the test object, discharge, earth and short it: at the 
connection point and at the far end. 

You may touch the plant parts that were under voltage only if they 
are visibly earthed and short-circuited. 

   

Next steps 

 Evaluating the transient image: 

 Chapter Evaluating the ICM transient image (on page 107) 

 Chapter Evaluating reflection images (on page 56) 

 Inserting the transient image into the report: Chapter Inserting a transient image into the 
report (on page 109) 
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12.4.4 Evaluating the ICM transient image 

Typical ICM traces are shown below. 

Fault is not ignited 

If the fault is not ignited, the transient wave is reflected from the open cable end with opposite 
polarity.  
 

 
 

t Pulse duration 
 

Transient image after a breakdown 

The breakdown produces a travelling wave at the fault that drifts between the connection point 
of the surge voltage generator and the fault with alternating polarity. The current part of the 
transient wave is recorded through an inductive coupling and displayed with the help of the 
time domain reflectometer. The time gap between the periodically repetitive transients is used 
to calculate the fault distance to the connection point. 

The first reflection contains an ignition lag (ti), i.e. the ionization time of the charger carrier 
before a breakdown. Therefore, the second or third reflection period is included for the 
evaluation. Subsequent periods are weakened by multiple reflections and can distort the 
measurement result.  

It can also happen that the impulse current does not generate a breakdown when the fault 
occurs for the first time and is reflected back with same polarity in the direction of the fault from 
the cable end. This doubles the applied voltage and leads to breakdown on the second 
occurrence of the fault.  

As each impedance change, such as joint or connection point, triggers reflections, they must 
be considered during the evaluation. This can make it difficult to evaluate a transient image in 
a branched cable.  

 
 

t Pulse duration 

ti Ignition lag time in the first reflection period (ionization time) 
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Procedure 
 

 

 

1. You can insert a horizontal auxiliary guide line to precisely position the cursors used for 
calculating the fault distance. To do this, right-click in the transient image and select the 
Add horizontal line context menu item. 

2. To move the line, click on the line and hold down the mouse button to drag it to the desired 
position. 

3. Double-click in the transient image at the beginning of a reflection period. 

A cursor is added (1). 

Note: Do not use the first reflection period for the evaluation, as it is distorted by the 
ignition lag. 

4. Double-click in the transient image at the end of this reflection period. 

A second cursor is added (2). 

5. If required, adjust the position of the cursor. To do this, click on the cursor flag and hold 
down the mouse button to move the cursor to the desired position. 

6. Right-click on the cursor flag of the first cursor and select the Select reference cursor 
context menu item. 

7. In the list, select the reference cursor that you set at the end of the reflection period.  

A bar (3) with the fault distance is displayed between the two cursors. 

The fault distance is produced from the distance between the two cursors minus the test 
lead length. 

8. To confirm the fault distance as the fault position, right-click on the blue bar and select the 
Confirm as fault position context menu item. 

The fault position is displayed in the cable image. A tolerance range is displayed around 
the pre-located fault position and the fault can be located within this range. The faulty 
phase is also indicated by a fault symbol. 

Recommendation: If the reflection periods are not clear, increase the voltage (if permitted) 
and repeat the measurement. 
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12.4.5 Inserting a transient image into the report 

1. If you want to insert the transient image in the report, click the Insert graph in report 
button. 

 

2. Enter a name for the graph and click the OK button. 
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With cable fault pin-pointing, the fault is located and marked precisely on the cable route. 

 Always begin the cable fault pin-pointing with a visual inspection.  

This will help you determine if the fault is due to visible external reasons, e.g. construction 
measures, and subsequently help you locate the fault quickly. 

You need additional devices to pin-point the cable fault. Once you have determined the 
precise location of the fault, you can enter the fault position in the BAUR GeoBase Map and 
insert the map section into the report. Further information: Chapter Inserting a map section 
with fault position into the report (on page 113) 

 

13.1 Acoustic pin-pointing 

13.1.1 About acoustic pin-pointing 

Acoustic pin-pointing is suitable for pin-pointing high-resistive cable faults and cable and 
phase breaks in buried cables and cable systems. The prerequisite for applying this method is 
that a breakdown must take place at the fault.  

Surge voltage pulses are fed into the faulty phases of the cable, which lead to breakdowns at 
the fault. The breakdowns result in an acoustic and magnetic signal. During acoustic 
pin-pointing, a ground microphone is used to look for the location where the breakdown noise 
is loudest. The breakdown noise can be best heard directly over the fault. 

 

13.1.2 Performing acoustic pin-pointing 

Safety instructions for the system’s surge mode 
   

 
 WARNING 

Potential differences between the system and the earth possible 

Danger to life or risk of injury due to electric shock. 

If a cable fault is located near to the system, there may be potential 
differences between the system and the earth in surge mode.  

 Place the system at a distance of several meters to the cable route 
or cable fault location.  

 If operating in ‘surge mode’, cordon off the system at distance of at 
least 1.5 m.  

During surge mode, people may only stand outside the cordoned off 
area. 

 Before starting surge mode, check the cable route for potential 
dangers. 

   
 

13 CABLE FAULT PIN-POINTING 
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Prerequisites 

 The test area is secured. 

 The test object is connected properly. 

Further information: Chapter Connecting the test object (on page 43) 

 The drawbars on the SA 32 SIM/MIM coupling unit are pushed in (position: SSG). 

 Required equipment: signal receiver, ground microphone  
   

 
 Follow the user manuals for the devices you are using for cable fault 

pin-pointing. 

   
 

Procedure 
   

1. SSG surge voltage generator 

 

Using the selector switch (left), choose a voltage range. 

2. Rotate the  rotary switch all the way to the left. 

3. 

 

Release the high voltage: To do this, press the  key. 

The system status changes to the Ready to switch on operating 
state. The red indicator light comes on. 

4. 

 

Using the imp/min selector switch, select the desired surge 

sequence: 

: slow surge sequence 

: rapid surge sequence 

Note: The number of surges emitted per minute for a slow or rapid 

surge sequence depends upon the surge voltage generator. 

Further information: Chapter SSG surge voltage generator (on 
page 24) 

5. 

 

Switch on the high voltage: To do this, press the  key. 

The system status changes to the In operation operating state. The 

red indicator light and the  key light up. 

6. 

 

Using the  rotary switch, increase the output voltage until the 
metallic noise of a breakdown can be heard. 

7.  Connect the signal receiver to the ground microphone. 
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8.  Locate the cable fault with the signal receiver and the ground 
microphone. 

If the breakdown noise can be heard clearly, use the acoustic 
signal to guide yourself during the pin-pointing. 

If the conditions are not suitable for a pure acoustic pin-pointing, 
you can also measure the magnetic signal. 

End measurement or connect other phase 

9. SSG surge voltage generator 

 

Rotate the  rotary switch all the way to the left. 

10. 

 

Press the  key. 

The system changes to the safe Ready for operation operating 
state. The green indicator light comes on. 

11. 

 

To protect the system against restarting, press the 
emergency off button and remove the safety key. 

 
DANGER  

Dangerous voltage on the test object and other live plant parts. Danger to life, risk of injury from high 

electric voltage.  

12.  Before touching the test object, discharge, earth and short it: at the 
connection point and at the far end. 

You may touch the plant parts that were under voltage only if they 
are visibly earthed and short-circuited. 

   

Next step: 

Inserting a map section with fault position into the report: Chapter Inserting a map section with 
fault position into the report (on page 113) 
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13.2 Inserting a map section with fault position into the report 

Prerequisites 

 The BAUR GeoBase Map is available. 

 A cable route is selected and its path marked on the BAUR GeoBase Map. 

Procedure 

1. Once you have pin-pointed the fault, correct the fault position in the BAUR system 
software if necessary: To do this, right-click on the fault position in the cable image and 
select the context menu item Properties.... 

2. Enter the correct fault position and click the OK button. 

3. To insert the map section with the fault position into the report, click the Insert graph in 
report button. 

4. Enter a name for the graph and click the OK button. 
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14.1 Creating reports 

You can create a report immediately after completing the cable fault location or later. 

Prerequisite 

A cable route is selected. 

Procedure 

1. Select the CABLE FAULT LOCATION tab. 

2. If required, create snapshots of the measurement results in the Fault analysis, 
Pre-location or Pin-pointing tabs and insert these graphs in the report. 

3. Select the Report tab. 

The preview displays the report for the selected cable route. The report contains cable 
data of the selected cable route and graphs of the measurement results, if any. 

4. If you want to show or hide existing graphs, in the graphs list, enable or disable the 
checkbox of the respective graph.  

5. If required, set up the report header. 

Further information: Chapter Setting up headers for reports (on page 114) 

6. To enter additional information on the entire report or on a graph, click in the Enter 
comment input field and enter the information. 

7. Click the Save button. 

8. To save the report under a different name, enter a name in the Report name input field. 

9. Click the OK button. 

The report is created with the relevant settings, saved with the cable route and displayed in 
the Dashboard in the LATEST REPORTS area. 

Note: You cannot modify or delete a saved report. 

10. To prepare another report for this cable route, click the New button. 
 

14.2 Setting up headers for reports 
1. In the dashboard, select the CABLE FAULT LOCATION tab and then the Report tab. 

2. To open the Settings dialog, click on the  icon. 

All settings that you make will apply for the report header. 

3. If required, enter an address in the Address input field. 

4. To set the address orientation, select one of the Text alignment radio buttons. 

5. Click the Select logo button to display a logo in the header. 

6. In the Select image dialog, in the File type selection list, select the file type and the folder 
where the image is located.  

7. Click the image you want. 

8. Click the OK button. 

The image is applied and displayed as a logo in the report header. 
 

14 REPORT PREPARATION  
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14.3 Exporting reports 
1. Open a saved report. 

Further information: Chapter Opening reports (on page 115) 

Alternately, you can directly export a report after the cable fault location by changing to the 
Report tab and carrying out the other steps described here. 

2. If required, set up the report header. 

Further information: Chapter Setting up headers for reports (on page 114) 

3. Click the Export button. 

4. In the File system list, select the folder where you want to export the report. 

5. To create a new folder, enter a name in the New folder input field and click the New folder 
button. 

6. To save the report under a different name, enter a name in the File name input field. 

Note: The file name must not contain the following characters: \ / : * ? "< > | 

7. Click the OK button. 

The report is saved in PDF format in the selected folder. 
 

14.4 Opening reports 
 In the Dashboard, double-click on the report you want in the LATEST REPORTS area. 

If several reports were created for several cable routes, the list of last reports can be very long. 
In such cases, you can open the report in another way. Proceed as follows: 

1. In the Dashboard, in the CABLE ROUTES area, select the cable route for which you want 
to open the report. 

2. Select the CABLE FAULT LOCATION tab and then the Report tab. 

3. Click the Load button. 

4. In the reports list, click on the report you want. 

5. Click the OK button. 
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15.1 Safety instructions for decommissioning 
   

 
DANGER  

Dangerous voltage in test object. 

Danger to life or risk of injury due to electric shock.  

 Before touching, discharge, earth and short-circuit:  The test 
object at the connection point and at the far end. 

 You may touch the parts that were under voltage only if they are 
visibly earthed and short-circuited. 

 Disconnect the earth connections as the last connection of the test 
setup. 

 Never disconnect the earth connections as long as power and other 
periphery connections are still connected. 

    
 

15.2 Taking the system and the test area out of operation 

Prerequisites 

 The system is in the Ready for operation operating state. 

Further information: Chapter “Ready for operation” operating state  (on page 33) 

 The test object is discharged, grounded and short-circuited.  

Further information: Chapter Discharging and earthing the test object (on page 118) 

Procedure 
   

 
 WARNING  

High electrical voltage 

Electric shock on touching live and active parts and due to residual 
charges if earthing is removed too early  

 Disconnect the earth connections as the last connection of the test 
setup. 

 Never disconnect the earth connections as long as power and other 
periphery connections are still connected. 

   
   

15 FINISHING A MEASUREMENT 



 

 

Syscompact 4000 Finishing a measurement 

822-180-2 117 / 150 

NOTICE 

Data loss as a result of incorrect switching off sequence for systems with UPS 

 Shut down the PC and only then switch off the uninterrupted power supply (UPS). 

   

1. Switch the system off on the surge voltage generator with the On/Off switch. 

   

 

   

2. Press the emergency off button on the surge voltage generator and remove the safety key 
from the emergency off button. 

3. Close the BAUR system software and shut down the PC: 

a. In the File menu, click on the Exit menu item to exit the BAUR system software. 

Alternately, click on the cross on the top right. 

b. Shut down the PC. 

The IRG time domain reflectometer is switched off. 

The UPS (if present) remains switched on. 

c. Systems with UPS: switch off the UPS. To do this, press the  key next to the PC 
monitor. 

4. To disconnect the system completely from the supply voltage, pull out the mains plug. 

5. Disconnect the connection cables in the reverse order from the order in which they were 
connected. 

Important: Finally, disconnect the earth cable last. 

6. Clean the connection cables. 

7. Wind up the connection cables onto the cable drum or clear them away. 

8. Further information: Chapter Unwinding and winding up the connection cables  (on page 
38) 

9. If necessary, remove the cordoning. 

10. Remove the earthing and the short-circuit on the test object only if no subsequent work is 
required and if the test object is to be put back into operation by the responsible 
individuals. 

11. Remove the barriers and marking of the test area. 
 

15.3 Exiting the measurement with the emergency off button 
during emergencies 
 Press the emergency off button on the SSG surge voltage generator. 

   

 

   

 The SSG is switched off. 
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 The SSG and the test object are discharged and short-circuited against the protective 
earth. 

Note: The test object is not automatically disconnected from the SSG. You must 
disconnect the test object from the SSG yourself. 

 The system status changes to the Ready for operation operating state and the green 
indicator light on the SSG illuminates. 

 No measurement can be performed as long as the emergency off button is pressed. 
 

15.4 Discharging and earthing the test object 
   

 
 DANGER 

Dangerous voltage in test object. 

Danger of electric shock or risk of injury 

 Before touching, discharge, earth and short-circuit: The test 
object at the connection point and at the far end. 

 You may touch the plant parts that were under voltage only if they 
are visibly earthed and short-circuited. 

 Connect the discharge and earth rod correctly to the station earth. 

 Only use the discharge and earth rod if its surface is clean and dry. 

 Hold the discharge and earth rod only at the handles! 

 Observe the minimum discharge period in accordance with the 
capacitance of the test object. 

   
 

15.4.1 Discharging 
 

 
 DANGER  

Dangerous voltage in test object 

Danger to life or risk of injury due to electric shock or electric arcs. 

 Use suitable personal protective equipment against electric shocks 
and arcing faults.  

 Keep a distance of at least 50 cm from the protective earthing cable 
of the discharge and earth rod. 

1. If not yet connected, connect the earth cable of the protective earthing cable of the 
discharge and earth rod to the station earth. 

2. Assemble the discharge rod: 

a. Screw the hook onto the discharge part. 
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b. Screw the discharge part onto the handle. 

 

3. Use the black handle to hold the discharge and earth rod and make contact with the test 
object by touching it with the tip of the discharge and earth rod. 

 

4. Observe the minimum discharge period in accordance with the capacitance of the test 
object. 
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15.4.2 Earthing 
 

 
 DANGER  

Dangerous voltage in test object 

Danger to life or risk of injury due to electric shock or electric arcs. 

 Use suitable personal protective equipment against electric shocks 
and arcing faults.  

 Keep a distance of at least 50 cm from the protective earthing cable 
of the discharge and earth rod. 

1. If not yet connected, connect the earth cable of the protective earthing cable of the 
discharge and earth rod to the station earth. 

2. Assemble the earth rod: Screw the hook into the handle. 

 

3. Contact the test object with the tip of the earth rod. 

 

4. Immediately after earthing, connect the earthing and short-circuit equipment to the test 
object.  
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16.1 Safety instructions 
 

 
 WARNING  

Dangerous voltage in system components and adjoining live plant 
parts 

Danger to life, risk of injury due to electric shock. 

 You may touch the live plant parts and connection fittings that were 
under voltage only after they have been discharged and earthed. 

 Cover the live plant parts properly. 

 

  
 

 
 WARNING  

Easily accessible live parts  

Danger to life, risk of injury due to electric shock. 

Once the system has been opened, live parts will be accessible. The 
surge voltage generator integrated within the system has a capacitor 
comprising two separate sub-capacitors. These sub-capacitors can still 
hold a residual charge, even when switched off. 

 Never take the system apart. Inside the device there are no 
components that could be serviced or repaired by the user. 

 Maintenance and repair work must only be carried out by personnel 
trained and authorised by BAUR. 

   

Establishing and ensuring voltage-free state 

1. Switch off the system before starting any maintenance and cleaning tasks.  

2. To disconnect the system completely from the power supply, pull out the mains plug. 

3. To protect the system against restarting, press the emergency off button on the surge 
voltage generator and remove the safety key from the emergency off button. 

4. Use safety signs to secure the work area.  
 

16.2 Maintenance schedule 
   

Interval Task 

16 MAINTENANCE AND CARE 
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Interval Task 

After each use  Check and clean the connection cables and the connection 
accessories. 

Further information: Chapter Checking and cleaning the connection 
cables and accessories (on page 125) 

Monthly  Check the condition of all connection cables. 

Further information: Chapter Checking and cleaning the connection 
cables and accessories (on page 125) 

Every 12 months  

(with frequent use, every 6 months 
or as required) 

 Check the discharging resistance of the discharge unit. 

Further information: Chapter Testing the discharge unit (on page 125) 

Every 12 months  
(with frequent use, every 6 months 
or as required) 

 Check the ignition voltage of the spark gap. 

Further information: Chapter Checking the ignition voltage of the spark 
gap (on page 122) 

Every 12 months  
(or as required depending on the 
conditions of use) 

 Clean the HV components inside the system. For this purpose, contact 
BAUR GmbH or your nearest BAUR representative 
(http://www.baur.eu/baur-worldwide). 

As required depending on the 
conditions of use 

 Clean the system components. 

Further information: Chapter Cleaning system components (on page 

126) 

   
 

16.3 Checking the ignition voltage of the spark gap 
 Check the ignition voltage of the spark gap every 12 months or as required. The ignition 

voltage must be between 500 and 1000 volts. 

Prerequisites 

 The drawbars on the SA 32 SIM/MIM coupling unit are pushed in (position: SSG). 

 The system is connected to the supply voltage. 

Further information: Chapter Connecting the system to the supply voltage (on page 50) 
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Procedure  
   

 

   

1.  Connect the system to the station earth. 

2.  Connect the HV connection cable and the screen of the HV 
connection cable to the station earth. 

3. 

 

Switch on the surge voltage generator using the On/Off switch. 

The green indicator light comes on. 

4. 

 

Using the selector switch (left), choose the voltage range 0 – 8 kV 
(position: 8 kV). 

5. Rotate the  rotary switch all the way to the left. 

6. 

 

Release the high voltage: To do this, press the  key. 

The system status changes to the Ready to switch on operating 
state. The red indicator light comes on. 

7. 

 

Set the imp/min selector switch to the  position (single surge). 

8. 

 

Switch on the high voltage: To do this, press the  key. 

The system status changes to the In operation operating state. The 

red indicator light and the  key light up. 
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9. 

 

Set the surge voltage to 4 kV using the  rotary switch. 

 

 

The capacitors in the surge voltage generator are charged up; you 
can read off the actual voltage on the voltage indicator. 

10. 

 

When the desired target voltage has been reached, turn the  
rotary switch for the output voltage all the way to the left. 

The capacitors are charged and ready to emit the voltage. 

11. 

 

Release a single surge: To do this, press the  key. 

12. 

 

Pay attention to the voltage indicator. 

A single surge is triggered. As long as the surge voltage is > 1 kV, 
the voltage should collapse with a single surge. 

13.  Repeat the measurement. Reduce the surge voltage step by step 
and release a single surge each time.  

As long as the surge voltage is > 1 kV, the voltage should collapse 
with a single surge. When the voltage is less than 1 kV, the voltage 
should no longer collapse. In this case, the ignition voltage is within 
the permissible range. 

If the voltage continues to collapse, even under 1 kV, contact your 
nearest BAUR representative 
(http://www.baur.eu/baur-worldwide). 

Completing the ignition voltage check 

14. 

 

Press the  key. 

The system changes to the safe Ready for operation operating 
state. The green indicator light comes on. 

 
DANGER  

Dangerous voltage on the test object and other live plant parts. Danger to life, risk of injury from high 

electric voltage. 

15.  Before touching the test object, discharge, earth and short it: at the 
connection point and at the far end. 

You may touch the plant parts that were under voltage only if they 
are visibly earthed and short-circuited. 
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16.4 Testing the discharge unit 
 Check the discharge unit works correctly every 12 months or as required. The discharging 

resistance of the discharge unit must be 16.5 kOhm (± 10%). 

Prerequisites 

 The resistance measurement is performed before the system is put into operation.  

This is because the residual charge in the surge capacitors and the thermal heating of the 
resistances influence the resistance measurement. 

 The system is switched off and is disconnected from the mains voltage. 

 The system is earthed correctly. 

Required equipment 

Ohmmeter 

Procedure 
   

 

   

1. Connect the ohmmeter to the HV connection cable and the screen of the HV connection 
cable.  

2. Measure the resistance between the HV connection cable and the screen.  

The resistance must be 16.5 kOhm (± 10%).  

3. If the measured resistance deviates from 16.5 kOhm by more than 10%, contact your 
nearest BAUR representative (http://www.baur.eu/baur-worldwide). 

 

16.5 Checking and cleaning the connection cables and 
accessories 
 

 
 WARNING  
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Dangerous voltage in system components and adjoining live plant 
parts 

Danger to life, risk of injury due to electric shock. 

 You may touch the live plant parts and connection fittings that were 
under voltage only after they have been discharged and earthed. 

 Cover the live plant parts properly. 

 

 

NOTICE  

Damage to cable due to aggressive cleaning agents 

 Do not use any abrasive, corrosive cleaning agents or strong solvents. 

 Ensure material compatibility. 

 Do not clean the connection cables with acetone or thinner.  

   

 

 Mild cleaning agents or petroleum ether 

 Lint-free cleaning cloth 

    

Checking and cleaning after each use 

1. Each time after using the system, clean the connection cables. 

2. Check the connection cables for damage. 

Cracks, breaks or other damage in the connection cable can damage the cable. 

3. If dirty, clean the connection accessories with a lint-free cloth. 

Dirty or corroded contacts can affect the measurement and are often the cause for device 
damage. 

Regular inspection 

 Every four weeks, check the condition of all connection cables. To do this, unwind the 
connection cables and examine them for cracks, damage and any dirt. 

 Regularly check all connection accessories for damage and dirt. 
 

16.6 Cleaning system components 
 

 
 WARNING  

Residual voltage in connection fittings and in the live system 
components 

Danger to life, risk of injury due to electric shock. 

 You may touch the connection fittings that were under voltage only 
after they have been discharged and earthed. 
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NOTICE  

Damage to the device may be caused by using the wrong cleaning agents 

 Do not use any abrasive, corrosive cleaning agents or strong solvents. 

 Ensure material compatibility. 

 Do not clean the product with acetone or thinner.  

 Never clean electrical devices with water. 

   

Prerequisites 

 Live plant parts located close by are covered.  

 The system is switched off and is disconnected from the supply voltage. Further 
information: Chapter Safety instructions (on page 121) 

 

1. If required, clean the device surfaces with mild detergent and a lint-free cloth.  

NOTICE! Damage to the device due to leaking fluids.  

2. Do not allow liquids to leak into the devices.  
 

16.7 Regular calibration  

It is important to calibrate the system regularly to ensure that the technical data given in this 
user manual are guaranteed. We recommend calibrating it once a year. The calibration may 
only be carried out by personnel trained and authorised by BAUR. 

 For information on calibration, contact your nearest BAUR representative 
(http://www.baur.eu/baur-worldwide). 

 

16.8 Updating the anti-virus software 

An anti-virus software is installed on the system by the manufacturer. 

 Update this anti-virus software regularly to be always protected from computer viruses. 
 

16.9 Replacing the PC's BIOS battery 

If the incorrect date and time are displayed in the operating system installed on the PC, the 
PC's BIOS battery may be too weak. 

Prerequisite 

The system is switched off and is disconnected from the mains voltage. 
   

 CR2032 button cell battery 

   

Procedure 

1. Depending upon the configuration of the system, there is a protective cover over the PC 
ports on the rear side of the system. Remove the protective cover. 

2. Remove the old button cell battery from the CR2032 battery compartment. 

3. Insert the new button cell battery into the CR2032 battery compartment. 
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Note the polarity of the button cell battery: the correct polarity is written on the battery 
compartment. 

4. Replace the protective cover back over the ports. 
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17.1 Error messages and corrective measures (notifications bar) 

 

 

The system generates information and error messages to help you while performing 
measurements. The error messages are displayed at the top right of the screen in the 
notifications bar. When you rest the mouse pointer over a system message, a tooltip displays 
detailed information. 

The error message is displayed until the fault is rectified.  
 

Error message Possible cause / Corrective measures 

No connection to 
IRG 

 

The connection to the integrated IRG time domain reflectometer has been interrupted. 

1. Exit the BAUR system software. 

2. Shut down the PC. 

3. Disconnect the system completely from the mains voltage. 

4. After approx. 1 minute, once again connect the system to the mains voltage. 

5. Switch on the system, start up the BAUR system software and repeat the desired 
procedure. 

If the fault occurs again: 

 Contact BAUR After Sales Service and provide the displayed error code or error 
message. 

IRG error Fault in IRG time domain reflectometer 

 Look for the error code in the table and rectify the problem according to the 
description. 

Further information: Chapter IRG errors (on page 131) 

If the fault occurs again: 

 Contact BAUR After Sales Service and provide the displayed error code or error 
message. 

17 ERRORS AND CORRECTIVE MEASURES 
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Error message Possible cause / Corrective measures 

No GPS signal Contact with a minimum of four GPS satellites is required for exact determination of the 
location. If the GPS signal is weak or contact is with three or fewer GPS satellites, the GPS 
signal cannot be received. For example, this can be the case in halls or streets with high 
building fronts.  

The function of the system and the BAUR system software is not affected. The display of 
the cable route and any fault positions via GPS in the BAUR GeoBase Map does not work. 

 Make sure that direct connection to GPS satellites is possible. 

 Wait for a valid GPS signal. 

No GPS connection The GPS receiver is not working. 

The function of the system and the BAUR system software is not affected. The display of 
the cable route and any fault positions via GPS in the BAUR GeoBase Map does not work. 

 Contact BAUR After Sales Service. 

 
 

17.2 Error messages and corrective measures (Measurement 
dialog) 
 

Error message Possible cause / Corrective measures 

Load determination failed.  The cause could be a faulty test setup or a low-resistive cable fault. 

1. Carry out an insulation resistance measurement. The measured resistance 
value should be high-resistive. 

2. If the value is low-resistive or the fault persists: Check the test setup. 

If the test setup is correct and the fault persists, there could possibly be a 
low-resistive cable fault. 

 Perform a TDR measurement. 

If there is no low-resistive cable fault and the fault reoccurs: 

 Close the dialog and repeat the process. 

If the fault occurs again: 

1. Exit the BAUR system software. 

2. Shut down the PC. 

3. Disconnect the system completely from the mains voltage. 

4. After approx. 1 minute, once again connect the system to the mains voltage. 

5. Switch on the system, start up the BAUR system software and repeat the 
desired procedure. 

If the fault occurs again: 

 Contact BAUR After Sales Service and provide the displayed error code or 
error message. 



 

 

Syscompact 4000 Errors and corrective measures 

822-180-2 131 / 150 

Error message Possible cause / Corrective measures 

Short-circuit during load 
determination 

 Check the test setup. 

 Close the dialog and repeat the process. 

If the fault occurs again: 

1. Exit the BAUR system software. 

2. Shut down the PC. 

3. Disconnect the system completely from the mains voltage. 

4. After approx. 1 minute, once again connect the system to the mains voltage. 

5. Switch on the system, start up the BAUR system software and repeat the 
desired procedure. 

If the fault occurs again: 

 Contact BAUR After Sales Service and provide the displayed error code or 
error message. 

Over-voltage during load 
determination 

 Check the test setup. 

If the fault occurs again: 

 Close the dialog and repeat the process. 

If the fault occurs again: 

1. Exit the BAUR system software. 

2. Shut down the PC. 

3. Disconnect the system completely from the mains voltage. 

4. After approx. 1 minute, once again connect the system to the mains voltage. 

5. Switch on the system, start up the BAUR system software and repeat the 
desired procedure. 

If the fault occurs again: 

 Contact BAUR After Sales Service and provide the displayed error code or 
error message. 

 
 

17.2.1 IRG errors 
   

Error message/error code Possible cause / Corrective measures 



 

 

Errors and corrective measures Syscompact 4000 

132 / 150 822-180-2 

Error message/error code Possible cause / Corrective measures 

No IRG trigger The integrated IRG time domain reflectometer cannot 
perform the desired action. 

 Close the dialog and repeat the process. 

If the fault occurs again: 

1. Exit the BAUR system software. 

2. Shut down the PC. 

3. Disconnect the system completely from the mains 
voltage. 

4. After approx. 1 minute, once again connect the 
system to the mains voltage. 

5. Switch on the system, start up the BAUR system 
software and repeat the desired procedure. 

If the fault occurs again: 

 Contact BAUR After Sales Service and provide the 
displayed error code or error message. 

IRG errors: [ERROR CODE] Fault in IRG time domain reflectometer 

 Look for the error code in the table and rectify the 
problem according to the description. 

If an error code is displayed that does not appear in this 
table: 

 Contact BAUR After Sales Service and provide the 
displayed error code. 

IRG request '[ERROR CODE]' rejected. 

Time limit for IRG request '[ERROR CODE]' has 
exceeded. 

WARN-IRG4000-CTRL-UNSAFE-TEMPERATURE The IRG time domain reflectometer has too high or too low 
an operating temperature. 

1. Close the dialog and wait a few minutes. 

2. Repeat the process. 

If the fault occurs again: 

 Contact BAUR After Sales Service and provide the 
displayed error code or error message. 

WARN-IRG4000-RMIO-UNSAFE-TEMPERATURE 

ERR-IRG4000-RMIO-VOLTAGE-AT-TDR-1-L1  Ensure that the extraneous voltage is switched off, or 
perform the TDR measurement with active voltage 
protection. 

ERR-IRG4000-RMIO-LOAD-IS-TO-HIGH The capacitive load is too high. 

ERR-IRG4000-CTRL-OPERATION-FAILED  Close the dialog and repeat the process. 

If the fault occurs again: 

1. Exit the BAUR system software. 

2. Shut down the PC. 

ERR-IRG4000-RMIO-OPERATION-FAILED 

ERR-IRG4000-RMIO-UARTPROTO-PARAMETER-
RANGE 
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Error message/error code Possible cause / Corrective measures 

HINT-IRG4000-CTRL-FPGA-MEASUREMENT 3. Disconnect the system completely from the mains 
voltage. 

4. After approx. 1 minute, once again connect the 
system to the mains voltage. 

5. Switch on the system, start up the BAUR system 
software and repeat the desired procedure. 

If the fault occurs again: 

 Contact BAUR After Sales Service and provide the 
displayed error code or error message. 

ERR-IRG4000-CTRL-INITIALIZATION-FAILURE 1. Exit the BAUR system software. 

2. Shut down the PC. 

3. Disconnect the system completely from the mains 
voltage. 

4. After approx. 1 minute, once again connect the 
system to the mains voltage. 

5. Switch on the system, start up the BAUR system 
software and repeat the desired procedure. 

If the fault occurs again: 

 Contact BAUR After Sales Service and provide the 
displayed error code or error message. 

ERR-IRG4000-CTRL-UARTPROTO-CRC 

ERR-IRG4000-RMIO-INITIALIZATION-FAILURE 

ERR-IRG4000-RMIO-UARTPROTO-CRC 

HINT-IRG4000-CTRL-EEPROM-FILESYSTEM 

HINT-IRG4000-CTRL-FGA-INIT-FACTORY 

HINT-IRG4000-CTRL-FPGA-INIT-MAINCONFIG 

HINT-IRG4000-CTRL-INTERNALFAULT 

HINT-IRG4000-CTRL-IO-EXPANDER 

HINT-IRG4000-CTRL-TEMPERATURESENSOR 

HINT-IRG4000-CTRL-UARTRMIO-TIMEOUT 

HINT-IRG4000-RMIO-ECHOMETER 

HINT-IRG4000-RMIO-EEPROM-FILESYSTEM 

HINT-IRG4000-RMIO-INTERNALFAULT 

HINT-IRG4000-RMIO-RESISTANCE-MEASUREM
ENT 

HINT-IRG4000-RMIO-TEMPERATURESENSOR 

HINT-IRG4000-RMIO-VOLTAGESOURCE 

 
 

17.3 PC faults (system with UPS) 
   

Fault Possible cause / Corrective measures 

The PC does not start, even 

though the  key has been 
pressed. 

The battery of the Uninterrupted Power Supply (UPS) is empty. 

1. Connect the system to the mains voltage. 

2. Wait a few minutes until the battery of the UPS is charged. 

3. Press the  key on the PC. 

The PC starts automatically. 
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Fault Possible cause / Corrective measures 

The PC does not start, even 

though the  On/Off key has 
been pressed. 

The uninterrupted power supply (UPS) is switched off. 

 Press the  key on the PC. 

The PC starts automatically. 

 The battery of the Uninterrupted Power Supply (UPS) is empty. 

1. Connect the system to the mains voltage. 

2. Wait a few minutes until the battery of the UPS is charged. 

3. Press the  key on the PC. 

The PC starts automatically. 

The  LED lights up. Extraneous voltage is present at the measurement input of the IRG time 
domain reflectometer. 

1. End the measurement immediately. 

2. Check the test setup. 

If extraneous voltage remains present: 

1. End the measurement immediately. 

2. Have the extraneous voltage switched off. 

For TDR measurements: 

 Perform the TDR measurement with activated voltage protection. 

The PC no longer responds. The PC has crashed. 

1. To switch off the PC, hold down the On/Off key  for approx. 5 
seconds. 

2. To restart the PC after it has been switched off, press the On/Off key  
once again. 

   

If the fault recurs after the recommended rectification measures have been performed: 

 Contact BAUR After Sales Service. 
 

17.4 PC faults (system without UPS) 
   

Fault Possible cause / Corrective measures 

The PC does not start, even 

though the  On/Off key has 
been pressed. 

The system is not supplied with voltage. 

1. Connect the system to the mains voltage. 

2. Press the On/Off key  on the PC. 
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Fault Possible cause / Corrective measures 

The  LED lights up. Extraneous voltage is present at the measurement input of the IRG time 
domain reflectometer. 

1. End the measurement immediately. 

2. Check the test setup. 

If extraneous voltage remains present: 

1. End the measurement immediately. 

2. Have the extraneous voltage switched off. 

For TDR measurements: 

 Perform the TDR measurement with activated voltage protection. 

The PC no longer responds. The PC has crashed. 

1. To switch off the PC, hold down the On/Off key  for approx. 5 
seconds. 

2. To restart the PC after it has been switched off, press the On/Off key  
once again. 

   

If the fault recurs after the recommended rectification measures have been performed: 

 Contact BAUR After Sales Service. 
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17.5 Online support session 

With your permission, BAUR After Sales can access your system computer, identify problems 
and quickly find a solution. To do this, you can use the already installed TeamViewer program 
which can be invoked from the user interface of the BAUR system software. Your engineers 
can also use this function to share the Desktop with the test engineer on site during the fault 
location and assist him in analysing the measurement results. 

The TeamViewer program meets the highest requirements for data protection and security. 
TeamViewer connections run over fully secured and encrypted data channels. Each time it is 
started, TeamViewer generates a new dynamic password, which together with the unique ID 
offers security against unauthorised access to the system. In this way, only persons to whom 
you have given the ID and password will have access to your computer. 

To allow an external expert access to your system computer, you will also require internet 
access. 

1. To set up internet access, insert a UMTS modem (UMTS stick) or a WLAN stick into the 
USB 3.0 port of the PC. 

2. If required, install additional software (e.g. drivers). 

3. Enter the necessary data for internet access. 

4. Note that online support by BAUR After Sales is available only during service hours after 
making a telephone appointment with one of our employees. During the entire online 
support session, you must remain near the system computer and in contact with the BAUR 
After Sales employee. 

Starting an online support session 

Prerequisites 

 Internet access is set up and working. 

 BAUR After Sales or the required technical expert is informed and is available. 

 Telephone connection is established. 

Procedure 

1. To start the online support session, in the Tools menu, select the Start online support 
session menu item. 

2. Call the BAUR After Sales or the technical expert and share the ID and password that will 
be displayed. 

BAUR After Sales or the technical expert can connect to your system computer and assist 
you. 

3. During the entire online support session, you must remain near the system computer and 
in contact with the BAUR After Sales employee. 
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18.1 Transportation 

18.1.1 Ensure the following when transporting 
   

NOTICE  

Damage to the device caused by improper transportation and incorrect storage 

 Always transport the device as intended. 

 Comply with the ambient conditions specified in the technical data for this system.  

   

 Protect all system components against the following during transportation: 

 Damage, 

 Vibrations,  

 Dampness and humidity.  

 Transport and store the system so that it always remains in an upright position. 

Otherwise the system may become damaged. 

 When transporting the system, secure the uncoiling brake to the cable drum. 
 

18.1.2 Transporting the system in vehicles 

1. Transport the system so that it always remains in an upright position.  

2. Secure the system to prevent it from sliding or tipping over. 
 

18.2 Storage 
 Store the system so that it always remains in an upright position. 

 During storage, comply with the ambient conditions specified in the technical data of the 
product. Information on the technical data is given in the corresponding section of this user 
manual.  

 Protect the system and components from humidity.  

 Protect the system against unauthorised access. 
 

18 TRANSPORTATION AND STORAGE 

19 WARRANTY AND AFTER SALES 
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Warranty 

For warranty claims, please contact BAUR GmbH or your local BAUR representative 
(http://www.baur.eu/baur-worldwide). Warranty is cancelled in case of misuse. Wear parts are 
excluded from the warranty.  

After Sales 

For questions contact BAUR GmbH or your BAUR representative 
(http://www.baur.eu/baur-worldwide). 

 

BAUR GmbH 

Raiffeisenstraße 8 
6832 Sulz / Austria 
service@baur.at 
www.baur.eu 
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The final decommissioning and disposal of the system must be carried out only in compliance 
with country-specific laws, regulations and standards.  

System components do not belong in the domestic waste.  

 Dispose of electrical system components in accordance with the applicable national 
regulations.  

 Dispose of the various system components in an environmentally friendly manner and in 
accordance with the applicable national regulations. 

 

20 DISPOSAL 
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21.1 Declaration of conformity for the Syscompact 4000 

We 
 

 
 

declare, under our sole responsibility, that the BAUR product 

Syscompact 4000 cable fault location system 

to which this declaration refers, conforms to the following standards or standard documents: 

 Low Voltage Directive 2014/35/EC 

EN 61010-1:2010 

EN 50191:2010 

 EMC Directive 2014/30/EU 

EN 55011:2009 + A1:2010 

EN 61000-4-2:2009 

EN 61000-4-4:2012 

 Environmental testing 

EN 60068-2-ff 

 

Signed: Dr. Markus Baur, CEO 

 

Sulz, 11/10/2017 
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21.2 Declaration of Conformity for IRG 4000 

We 
 

 
 

declare, under our sole responsibility, that the BAUR product 

IRG 4000 BAUR time domain reflectometer 

to which this declaration refers, conforms to the following standards or standard documents: 

 Low Voltage Directive 2014/35/EC 

EN 61010-1:2010 

 EMC Directive 2014/30/EU 

EN 55011:2009 + A1:2010 

EN 61000-3-2:2014 

EN 61000-4-2:2009 

EN 61000-4-4:2012 

EN 61000-4-5:2014 

EN 61000-4-11:2004 

 Environmental testing 

EN 60068-2-ff 

 

Signed: Dr. Markus Baur, CEO 

 

Sulz, 11/10/2017 
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21.3 Declaration of conformity for SSG 1100, SSG 1500 and SSG 
2100 

We 
 

 
 

declare, under our sole responsibility, that the BAUR product 

SSG 1100 / SSG 1500* / SSG 2100* surge voltage generators 

to which this declaration refers, conforms to the following standards or standard documents: 

 Low Voltage Directive 2014/35/EC 

EN 61010-1:2010 

EN 50191:2010 

 EMC Directive 2014/30/EU 

EN 55011:2009 + A1:2010 

EN 61000-4-2:2009 

EN 61000-4-4:2012 

 Environmental testing 

EN 60068-2-ff 

 

Signed: Torsten Berth, Technical Director 

  Dr. Eberhard Paulus, Director QM/QS 

 

Sulz, 14/12/2015 

 

* Options instead of SSG 1100 
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21.4 Declaration of conformity for the SA 32 

We 
 

 
 

declare, under our sole responsibility, that the BAUR product 

SA 32 SIM/MIM coupling unit 

to which this declaration refers, conforms to the following standards or standard documents: 

 Low Voltage Directive 2014/35/EC 

EN 61010-1:2010 

 EMC Directive 2014/30/EU 

EN 55011:2009 + A1:2010 

EN 61000-4-2:2009 

EN 61000-4-4:2012 

 Environmental testing 

EN 60068-2-ff 

 

Signed: Torsten Berth, Technical Director 

  Dr. Eberhard Paulus, Director QM/QS 

 

Sulz, 14/12/2015 



 

 

User interface Syscompact 4000 

144 / 150 822-180-2 

 

 

The user interfaces are described in the Online Help of the BAUR system software. 

 

22 USER INTERFACE 
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A 

About acoustic pin-pointing • 110 

About cable sheath testing • 84 

About cable testing • 84 

About determining the breakdown 
voltage • 81 

About insulation resistance 
measurement • 77 

About the ICM method • 102 

About the SIM/MIM method • 95 

About the TDR method • 88 

About this manual • 9 

Acoustic pin-pointing • 110 

Activating options • 65 

Activating the simulation mode • 65 

Adding a horizontal line in the 
reflection image • 63 

Adding images • 69 

Adding, moving and saving cursors • 
58 

Adjusting the cable length and 
velocity of propagation • 94 

Avoiding dangers, taking safety 
measures • 13 

B 

Backing up data • 73 

Basic settings for fault location 
methods • 73 

BAUR GeoBase Map • 19 

BAUR system software for cable fault 
location • 19 

C 

Cable and cable sheath testing • 84 

Cable fault analysis • 77 

Cable fault pin-pointing • 110 

Cable fault pre-location • 88 

Calculating the fault distance • 60 

Calculating the minimum discharge 
time • 31 

Changing the user properties • 55 

Checking and cleaning the 
connection cables and accessories • 
125 

Checking and maintaining the safety 
devices • 14 

Checking the ignition voltage of the 
spark gap • 122 

Checks to perform before 
commissioning • 40 

Cleaning system components • 126 

Commissioning • 52 

Comparing resistance values with the 
previous values • 80 

Confirming cursor positions • 59 

Connecting an external device to the 
system • 50 

Connecting the HV connection cable 
to a phase of the test object • 43 

Connecting the HV connection cable 
to the test object screen • 48 

Connecting the system • 41 

Connecting the system to the supply 
voltage • 50 

Connecting the test object • 43 

Connection cables to the KTG M3 
cable drum rack • 29 

Creating reports • 114 

Creating users • 54 

D 

Danger during the system’s surge 
mode • 16 

Dangers from road traffic • 16 
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Dangers when working with high 
voltage • 14 

Data exchange • 71 
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4000 • 141 
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32 • 143 
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Discharge and earthing device • 30 
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Disposal • 139 
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Instructions for the operator • 12 
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